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Rockwell Automation Network Device Library Reference Manual

Important User Information
Read this document and the documents listed in the additional resources section about installation, configuration, and 
operation of this equipment before you install, configure, operate, or maintain this product. Users are required to familiarize 
themselves with installation and wiring instructions in addition to requirements of all applicable codes, laws, and standards.

Activities including installation, adjustments, putting into service, use, assembly, disassembly, and maintenance are required to 
be carried out by suitably trained personnel in accordance with applicable code of practice.

If this equipment is used in a manner not specified by the manufacturer, the protection provided by the equipment may be 
impaired.

In no event will Rockwell Automation, Inc. be responsible or liable for indirect or consequential damages resulting from the use 
or application of this equipment.

The examples and diagrams in this manual are included solely for illustrative purposes. Because of the many variables and 
requirements associated with any particular installation, Rockwell Automation, Inc. cannot assume responsibility or liability for 
actual use based on the examples and diagrams.

No patent liability is assumed by Rockwell Automation, Inc. with respect to use of information, circuits, equipment, or software 
described in this manual.

Reproduction of the contents of this manual, in whole or in part, without written permission of Rockwell Automation, Inc., is 
prohibited.

Throughout this manual, when necessary, we use notes to make you aware of safety considerations.

These labels may also be on or inside the equipment to provide specific precautions.

The following icon may appear in the text of this document.

WARNING: Identifies information about practices or circumstances that can cause an explosion in a hazardous environment, which 
may lead to personal injury or death, property damage, or economic loss.

ATTENTION: Identifies information about practices or circumstances that can lead to personal injury or death, property damage, 
or economic loss. Attentions help you identify a hazard, avoid a hazard, and recognize the consequence.

IMPORTANT Identifies information that is critical for successful application and understanding of the product.

SHOCK HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that dangerous voltage 
may be present.

BURN HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that surfaces may reach 
dangerous temperatures.

ARC FLASH HAZARD:  Labels may be on or inside the equipment, for example, a motor control center, to alert people to potential Arc 
Flash. Arc Flash will cause severe injury or death. Wear proper Personal Protective Equipment (PPE). Follow ALL Regulatory 
requirements for safe work practices and for Personal Protective Equipment (PPE).

Identifies information that is useful and can help to make a process easier to do or easier to understand.
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Device Object Libraries 
Overview

Our Device Object Libraries enable you to easily interface with Rockwell 
Automation® intelligent devices like drives, motion, network switches, 
sensors, IO and more. The libraries contain tested, documented, and lifecycle-
managed objects which can be used with machine builder, process, and 
packaged libraries or as standalone components. Device objects include HMI 
faceplates for FactoryTalk® View ME/SE and Studio 5000 View Designer® 
software and provide a user interface that seamlessly integrates with the 
products.

HMI faceplates are standard display files that provide a common user 
interface. These are HMI pop-up screens used to display detailed information 
related to a specific instruction or device. In systems that follow ISA 101.1 
design guidelines, faceplates are often referred to as Level 4 displays.

Pre-configured Device Objects include an Add-On Instruction Rung and an 
HMI Faceplate providing the following benefits:

• Collect, Process and Deliver Data between Smart Devices and 
Application Logic

• Detailed Device Data Collection and Delivery
• Enhanced Device Status and Diagnostics
• Common Control Interfaces maximizing Flexible Automation Device 

Selection & Application Code Reuse 

Device Object Use Cases:
• Basic Device Maintenance and Diagnostics
• Virtual Device Operations for Startup and Commissioning
• Operator and Program Control for Velocity Machine and Process 

Applications

Application Code Manager Studio 5000® Application Code Manager is a tool that can be used with Device 
Object Libraries to streamline project and machine development. This bulk 
coding tool allows you to easily design and standardize functionality with 
reusable application code.

Enable more efficient project development with reusable libraries of code:
• Quickly create and deploy projects through our Application Content 

Libraries
• Import Rockwell provided application content libraries to expedite 

system development

Device Object Libraries may be downloaded from the Product Compatibility 
and Download Center. Search for “Library”.

https://compatibility.rockwellautomation.com/Pages/home.aspx
https://compatibility.rockwellautomation.com/Pages/home.aspx
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• Build your own reusable code that can be managed and deployed across 
your entire enterprise

• Easily configure objects in bulk with reusable code to increase 
application development, no additional programming is necessary

• Consolidate content for Studio 5000 Logix Designer®, FactoryTalk® 
View Studio, FactoryTalk® Alarms & Events, FactoryTalk® Historian to 
configure an object a single time and generate content for each of those 
software packages.

See the section on Using the Library with Application Code Manager for more 
details.

Other Application Code 
Libraries

This Device Object Library may be used in harmony with other Application 
Code Libraries including other Device Object Libraries (Network, IO, IO-Link, 
Safety Device Libraries) or Application Libraries (PlantPAx® Process Objects 
library, Machine Builder Libraries). All libraries are intended to follow similar 
design philosophies to provide a consistent experience for operators and 
maintenance staff.

A complete list of Application Code Libraries from Rockwell Automation® 
follows.

Libraries can be accessed from the 
Product Compatibility and Download Center.

Item Description

PlantPAx® Process Library Rockwell Automation® Library of Process Objects provides application templates, Endress + Hauser library objects, 
Application Code Manager library objects, and tools and utilities for PlantPAx® DCS applications.
Includes the following:
• Graphics for built-in instructions
• HMI images and Help files
• Logix diagnostic objects
• Process objects
• Control strategies
• Sequencer objects
• PlantPAx® Configuration Tools for Tags, Alarms and Historian
• Color Change
• Historian -- Asset Framework template and objects

Machine Builder Libraries Tested, documented and life-cycle managed library objects and faceplates for use with Studio 5000® Application Code 
Manager for use primarily with OEM and discrete machine applications.

Common Application Libraries Commonly used application library objects and faceplates for use with Studio 5000® Application Code Manager 
including basic functions like unit conversion and data collection.

Independent Cart Technology Libraries ICT Libraries for iTRAK and MagneMotion including MagneMover LITE and QuickStick for Studio 5000® Application Code 
Manager

I/O Device Library Provides objects for Rockwell Automation® 1756, 1769, 1734, 1794, 1738, 1732E, 1719, 5069, 5094 I/O modules 
including pre-configured status and diagnostic faceplates 

IO-Link Device Library Provides IO-Link master and sensor objects including pre-configured status and diagnostic faceplates

Network Device Library Provides objects for Stratix® switch and Device Level Ring network objects

Power Device Library Provides objects for discrete, velocity, motion, and power monitor devices

Safety Device Library Provides safety objects to interface with safety I/O

Electrical Protection Device Library Provides a standard to represent protection devices within your electrical distribution system

https://compatibility.rockwellautomation.com/Pages/home.aspx
https://compatibility.rockwellautomation.com/Pages/home.aspx
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Software and Firmware 
Upgrades

When you update software or firmware revisions, we recommend that you 
verify the impact on performance and memory utilization before 
implementing the upgrade on the production system. For FactoryTalk® View 
or ControlLogix®® platforms, we recommend that you review the release notes 
and verify the impact of the upgrade on performance and memory utilization.

You can also verify the compatibility of the upgrade with the installed software 
and operating systems in use on your system. See the Product Compatibility 
and Download Center.

Rockwell Automation® 
Services and Support

System Support offers technical assistance that is tailored for control systems. 
Some of the features include the following:

• Highly experienced team of engineers with training and
systems experience

• Use of online remote diagnostic tools
• Access to otherwise restricted TechConnectSM Knowledgebase content
• 24-hour, 7 days per week, 365 days per year of phone-support coverage upgrade 

option

For more information, contact your local distributor or Rockwell Automation® 
representative or see http://www.rockwellautomation.com/support.

You can view or download publications at 
http://www.rockwellautomation.com/literature. To order paper copies of 
technical documentation, contact your local Allen-Bradley® distributor or
Rockwell Automation® sales representative.

https://compatibility.rockwellautomation.com/Pages/home.aspx
https://compatibility.rockwellautomation.com/Pages/home.aspx
http://www.rockwellautomation.com/support
http://literature.rockwellautomation.com
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Chapter 1

Rockwell Automation® Network Device Library

The Network Device Library is a tested, documented, and life cycle managed 
object library. The Device Library provides pre-configured status and 
diagnostic faceplates and AOI sets for Rockwell Automation® network devices. 
The Network Device Objects may be used with Machine Builder, Process, and 
Packaged Libraries or as standalone components. Network Device Library add-
on instructions objects collect, process, and deliver data between hardware 
devices and application logic.

The Network Device Library includes Add-On Instructions (AOIs) and HMI 
Faceplates for Allen-Bradley® Stratix® Switch products, Device-Level Ring 
(DLR) network monitoring and Parallel Redundancy Protocol (PRP) network 
monitoring. 

This document includes the functional requirements of the Stratix® Switch , 
Device-Level Ring and Parallel Redundancy Protocol device objects.

Compatibility Compatible Software
• Studio 5000 Logix Designer® v30.02.00, v31.02.00, v32.04.00, v33.01.01, 

or v34.01.00 for PAC Application Development
• Studio 5000® Application Code Manager v4.0 and later for bulk code 

configuration
• Studio 5000 View Designer® v5.01 and later for PanelView™ 5000 

Application Development
• FactoryTalk® View Studio for FactoryTalk View ME/SE or PanelView™ 

Plus Application Development
• Stratix® Switch Device Objects: v10.00.01 and later 
• Device Level Ring Objects: v11.00.00 and later
• Parallel Redundancy Protocol Objects: v11.00.00 and later

Compatible Hardware
• PanelView™ 5500/5510/5310 with v5 or later firmware
• PanelView™ Plus 

• Stratix® Switch Device Objects: v11 or later firmware
• Device Level Ring Objects: v11 or later firmware

The Network Device Library may be downloaded from the Product 
Compatibility and Download Center. Search for Network Device Library.

https://compatibility.rockwellautomation.com/Pages/home.aspx
https://compatibility.rockwellautomation.com/Pages/home.aspx
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• Parallel Redundancy Protocol Objects: v11 or later firmware
• ControlLogix®/GuardLogix® 5570 or 5580 controller with v30.011 or 

later firmware
• CompactLogix™/Compact GuardLogix® 5580 or 5570 controller with 

v30.011 or later firmware
• Stratix® 2500 with v2.003 or later firmware
• Stratix® 5200 with v17.12.01 or later firmware
• Stratix® 5400/5410 with IOS rev 15.2(7)E1a or later
• Stratix® 5700/ArmorStratix™ 5700 with IOS rev 15.2(7)E1a or later
• Stratix® 5800 with IOS rev 17.02(7)E1a or later

Summary of Changes This publication contains the following new or updated information. This list 
includes substantive updates only and is not intended to reflect all changes.

Footprint Each instruction requires memory footprint within the Logix controller. The 
following characteristics apply:

• Definition: Estimated memory required to store the object definition, 
including all dependents

• Instance: Estimated memory required per object instantiated.
• Execution (L85E): Estimated execution time / scan footprint evaluated 

in 1756-L85E PAC

• Execution (L75): Estimated execution time / scan footprint evaluated in 
1756-L75 PAC

Topic Page
Added Parallel Redundancy Protocol PRP Device Object 157-170
Added references to Stratix 5200 device support all

Device Object Footprint

Device Object Defintion (kB) Instance (kB) Execution (µs)
raC_Dvc_StratixSwitch 161.41 18.34 123
raC_Opr_NetDLR1_ 141.00 26.00 42
raC_Opr_NetDLR1_Lite 105.44 11.32 68
raC_Dvc_NetDLR3 165.00 27.00 48
raC_Opr_NetPRP 111.09 12.50 340

Device Object Footprint

Device Object Defintion (kB) Instance (kB) Execution (µs)
raC_Opr_NetDLR1_ 161.00 26.00 820
raC_Opr_NetDLR1_Lite 117.83 11.47 480
raC_Dvc_NetDLR3 191.00 27.00 890
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Additional resources For a complete understanding of Rockwell Automation safety applications it is 
recommended to review the following documents.

Resource Description
Stratix Ethernet Device Specifications 
Technical Data, 1783-TD001 Provides specifications for Stratix® Ethernet switches and other devices.

Deploying Device Level Ring within a 
Converged Plantwide Ethernet 
Architecture Design Guide, 
publication ENET-TD015

Represents a collaborative development effort from Rockwell Automation and 
Cisco Systems®. Provides application requirements, technology, and design 
considerations to deploy Device Level Ring (DLR) technology through a plant-wide 
Industrial Automation and Control System (IACS) network infrastructure.

EtherNet/IP Device Level Ring 
Application Technique ENET-AT007

This publication describes DLR network operation, topologies, configuration 
considerations, and diagnostic methods. 

Stratix Managed Switches User 
Manual, 1783-UM007

Describes how to configure, monitor, and troubleshoot Stratix® 5400, 5410, 5700, 
8000, 8300, and ArmorStratix™ 5700 managed switches.

ControlLogix EtherNet/IP Network 
Devices User Manual, 1756-UM004

Describes how to configure and use EtherNet/IP devices to communicate on the 
EtherNet/IP network.

Ethernet Reference Manual, 
publication ENET-RM002

Describes basic Ethernet concepts, infrastructure components, and 
infrastructure features.

Troubleshoot EtherNet/IP Networks 
Application Technique, publication 
ENET-AT003

Describes troubleshooting techniques for Integrated Architecture products on 
EtherNet/IP networks.

Ethernet/IP Parallel Redundancy 
Protocol Application Technique 
ENET-AT006D 

Describes how you can configure a Parallel Redundancy Protocol (PRP) network 
with a compatible device or switch.

Deploying Parallel Redundancy 
Protocol within a Converged 
Plantwide Ethernet Architecture 
ENET-TD021B

Designing & Deploying the Parallel Redundancy Protocol within a Converged 
Plantwide Ethernet Architecture (CPwE PRP)

Application Code Manager User 
Manual LOGIX-UM003

Studio 5000® Application Code Manager is a tool that enables more efficient 
project development with libraries of reusable code.

https://literature.rockwellautomation.com/idc/groups/literature/documents/td/1783-td001_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/td/enet-td015_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/td/enet-td015_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/1783-um007_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/1756-um004_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/rm/enet-rm002_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/at/enet-at003_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/at/enet-at007_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/logix-um003_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/at/enet-at006_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/at/enet-at006_-en-p.pdf


https://literature.rockwellautomation.com/idc/groups/literature/documents/td/enet-td021_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/at/enet-at003_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/at/enet-at003_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/at/enet-at006_-en-p.pdf
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Chapter 2

Library Components

The Network Device Library is a tested, documented, and life cycle managed 
object library. The Device Library provides pre-configured status and 
diagnostic faceplates and AOI sets for Allen-Bradley® Stratix® Switches, Device 
Level Ring (DLR) networks, and Parallel Redundancy Protocol (PRP) networks. 
The Network Device Objects may be used with Machine Builder, Process, and 
Packaged Libraries or as standalone components. Network Device Library add-
on instructions objects collect, process, and deliver data between hardware 
devices and application logic.

Network Device Instructions The Network Device Library includes instructions to interface with Stratix® 
managed network switches and Device Level Ring (DLR) networks. 

A single Stratix® Switch Add-On Instruction is used for any compatible 
Stratix® or ArmorStratix™ managed switch (2500/ 5400/5410/5700/5800). 
Specific HMI faceplates are used for each Stratix® model.

The Stratix® Switch Objects included are as follows:
• raC_Dvc_Stratix® - Generic Stratix® Switch

The Device Level Ring (DLR) add-on instructions support either a single ring 
with up to 12 nodes (DLR1 Lite), a single ring with up to 56 nodes (DLR1) or up 
to 3 rings each with up to 54 nodes (DLR3). The DLR1 Add-On Instruction can 
be paired with either the 24 node or 56 node HMI faceplates depending on the 
network size. It is recommended to use a PanelView™ Plus 7 with a minimum 
resolution of 640x390 for 24 node HMI faceplates and a minimum resolution of 
800x600 for 56 node HMI faceplates.

The Device Level Ring (DLR) Objects includes are as follows:
• raC_Opr_NetDLR1
• raC_Opr_NetDLR1_Lite
• raC_Opr_NetDLR3

The Parallel Redundancy Protocol (PRP) Objects includes are as follows:
• raC_Opr_NetPRP

There are two types of instruction in this library:
• Device (Dvc): instruction used for devices (e.g. Stratix® Switch).
• Operation (Opr): instruction used for operation (e.g. Network 

Monitoring)
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Network Device Instructions

Add-On Instruction Compatible
Device/Network FactoryTalk® View ME Faceplate FactoryTalk® View SE Faceplate Version

raC_Dvc_Stratix

Stratix® 2500 (raC-12_03-ME) raC_Dvc_S2500-Faceplate (raC-12_03-SE) raC_Dvc_S2500-Faceplate 12.03
Stratix® 5200 (raC-12_03-ME) raC_Dvc_S5200-Faceplate (raC-12_03-SE) raC_Dvc_S5200-Faceplate 12.03
Stratix® 5400 (raC-12_03-ME) raC_Dvc_S5400-Faceplate (raC-12_03-SE) raC_Dvc_S5400-Faceplate 12.03
Stratix® 5410 (raC-12_03-ME) raC_Dvc_S5410-Faceplate (raC-12_03-SE) raC_Dvc_S5410-Faceplate 12.03
Stratix® 5700
ArmorStratix™ 5700 (raC-12_03-ME) raC_Dvc_S5700-Faceplate (raC-12_03-SE) raC_Dvc_S5700-Faceplate 12.03

Stratix® 5800 (raC-12_03-ME) raC_Dvc_S5800-Faceplate (raC-12_03-SE) raC_Dvc_S5800-Faceplate 12.03

raC_Opr_NetDLR1

Single Ring
24 Notes Maximum (raC-12_02-ME) raC_Opr_NetDLR1_24Node-Faceplate (raC-12_02-SE) raC_Opr_NetDLR1_24Node-Faceplate 12.02

Single Ring
56 Notes Maximum (raC-12_02-ME) raC_Opr_NetDLR1_56Node-Faceplate (raC-12_02-SE) raC_Opr_NetDLR1_56Node-Faceplate 12.02

raC_Opr_NetDLR1_Lite Single Ring
12 Nodes Maximum (raC-12_02-ME) raC_Opr_NetDLR1_12Node-Faceplate (raC-12_02-SE) raC_Opr_NetDLR1_12Node-Faceplate 12.02

raC_Opr_NetDLR3 3-Rings Maximum
56 Nodes Maximum (raC-12_02-ME) raC_Opr_NetDLR3_56Node-Faceplate (raC-12_02-SE) raC_Opr_NetDLR3_56Node-Faceplate 12.02

raC_Opr_NetPRP

PRP Node Table 
applicable with 1756-
EN2TP, 1756-EN4TR, 
5094-AEN2TR And 
maximum 240 PRP 
Nodes

(raC-12_03-ME) raC_Opr_NetPRP-Faceplate (raC-12_03-SE) raC_Opr_NetPRP-Faceplate 12.03

Add-On Instruction Compatible
Device/Network Studio 5000 View Designer® Faceplate Version

raC_Dvc_Stratix

Stratix® 2500 (raC-12_02-VD) raC_Dvc_S2500_FP 12.03
Stratix® 5200 (raC-12_02-VD) raC_Dvc_S5200_FP 12.03
Stratix® 5400 (raC-12_02-VD) raC_Dvc_S5400-FP 12.03
Stratix® 5410 (raC-12_02-VD) raC_Dvc_S5410-FP 12.03
Stratix® 5700
ArmorStratix™ 5700 (raC-12_02-VD) raC_Dvc_S5700-FP 12.03

Stratix® 5800 (raC-12_02-VD) raC_Dvc_S5800-FP 12.03

raC_Opr_NetDLR1

Single Ring
24 Notes Maximum (raC-12_02-VD) raC_Opr_NetDLR1_24Node-FP 12.02

Single Ring
56 Notes Maximum (raC-12_02-VD) raC_Opr_NetDLR1_56Node-FP 12.02

raC_Opr_NetDLR1_Lite Single Ring
12 Nodes Maximum (raC-12_02-VD) raC_Opr_NetDLR1_12Node-FP 12.02

raC_Opr_NetDLR3 3-Rings Maximum
56 Nodes Maximum (raC-12_02-VD) raC_Opr_NetDLR3_56Node-FP 12.02

raC_Opr_NetPRP

PRP Node Table 
applicable with 1756-
EN2TP, 1756-EN4TR, 
5094-AEN2TR And 
maximum 240 PRP 
Nodes

(raC-12_03-VD) raC_Opr_NetPRP-FP 12.03
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Library Folders and Files When you extract the library from the downloaded .zip folder, you will find the 
following folder and file structure. Note that some items are generalized with 
TYPE (e.g. Dvc, Opr, Tec) and OBJECT (e.g. 45DMS, 46CLR, etc). The major and 
minor versions are represented by X and Y respectively.

Level 1 Level 2 Level 3 File Type Description
ApplicationCodeManagerLibraries Folder Application Code Manager files

Attachments (.HZ1 and .txt files) Folder ACM Object Attachments
(RA-LIB)_Device_Asset-Control_GROUP_raC_Dvc_OBJECT_(X.Y).HSL4 HSL4 ACM Asset-Control Object
(RA-LIB)_Device_Device_GROUP_raC_Dvc_OBJECT_(X.Y).HSL4 HSL4 ACM Device Object

HMI - FactoryTalk® View ME Folder FactoryTalk® View ME files
Displays - gfx Folder FT View ME display files

(raC-X_YY-ME) raC_TYPE_ OBJECT-faceplate.gfx GFX Object Faceplate display
Global Objects - ggfx Folder FT View ME Global Object files

(raC-X-ME) Graphic Symbols - LIBRARY.ggfx GGFX Graphic Symbol/Launch Button 
global objects

(raC-X-ME) Toolbox - LIBRARY.ggfx GGFX Toolbox global objects
HMI - FactoryTalk® View SE Folder FactoryTalk® View SE Files

Displays - gfx Folder FT View SE display files
(raC-X_YY-SE) raC_TYPE_ OBJECT-faceplate.gfx GFX Object Faceplate display

Global Objects - ggfx Folder FT View SE Global Object files

(raC-X-SE) Graphic Symbols - LIBRARY.ggfx GGFX Graphic Symbol/Launch Button 
global objects

(raC-X-SE) Toolbox - LIBRARY.ggfx GGFX Toolbox global objects
HMI - ViewDesigner - vpd Folder View Designer Files

(raC-X_YY-VD) raC_Dvc_Stratix.vpd
(raC-X_YY-VD) raC_Opr_NetDLR.vpd VPD Object faceplate and graphic 

symbol/launch buttons
HMI FactoryTalk® View Images - 
png

Folder FT View ME/SE image files
images.png PNG FTView ME/SE images

Reference Manuals Folder Manuals
RAC-RM400B.pdf PDF Reference manual

Studio 5000 Logix Designer Files - 
L5X Folder Studio 5000® AOI and RUNG 

import files
raC_TYPE_ OBJECT_X.YY_RUNG.L5X L5X Object rung import
raC_TYPE_ OBJECT_X.YY_AOI.L5X L5X Object AOI import

ReadMe.txt TXT Explanation of standard vs 
PlantPAx® files

Videos Folder How-to and Operational 
Overview Videos

How_To_Import_and_Configure_TYPE_Objects_in_FTViewME.mp4 MP4 How-to Video
How_To_Import_and_Configure_TYPE_Objects_in_FTViewSE.mp4 MP4 How-to Video
How_To_Import_and_Configure_TYPE_Objects_in_LogixDesigner.mp4 MP4 How-to Video
How_To_Configure_TYPE_Objects_in_ViewDesigner.mp4 MP4 How-to Video
Operational_Overview_of_OBJECT_Faceplate.mp4 MP4 Operational Overview video

LIBRARYDeviceLibrary_ReleaseNotes_vX.YY.pdf PDF Release Notes
ReadMe.txt TXT Explanation of setup.cmd

SetUp.cmd CMD Application Code Manager setup 
script to register library
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Visualization Files Each Add-On Instruction has associated visualization files that provide a 
common user interface. The Network Device Library supports two HMI 
options each with their own files supplied:

• FactoryTalk® View ME (Machine Edition)
• FactoryTalk® View SE (Site Edition)
• Studio 5000 View Designer®

FactoryTalk® View Visualization Files

You must import these files in the following order:
• Images (.png files)
• Global Objects(.ggfx file type)
• HMI faceplates (.gfx file type)

Global object files contain Graphic Symbols that are created once and 
referenced multiple times on multiple displays in an application. When 
changes are made to a global object, all instances in the application are 
automatically updated.

Global objects serve two purposes:
• Toolbox files contain common elements that are used to build faceplate 

displays.
• Graphic Symbols files contain device symbols or launch buttons that 

you can use to build your application displays. Select the symbol to 
open the corresponding faceplate display.

Standard display files, commonly called faceplates, provide a common user 
interface.

Studio 5000 View Designer® Visualization Files

Two Studio 5000 View Designer® project files are supplied which contain 
faceplates and launch buttons for the Network Device Library. These are split 
into a project for Stratix® switch objects (raC_12_02-VD) raC_Dvc_Stratix.vpd 
and a project for Device Level Ring Objects (raC-12_02-VD) 
raC_Opr_NetDLR.vpd. These files are found in the HMI - ViewDesigner - vpd 
folder. Inside of the VPD file you will find a the required display files inside of 
the User-Defined Screens folder.

File Type Abbreviations FactoryTalk® View ME FactoryTalk® View SE Description

Images (.png)

All .png files in the HMI FactoryTalk® View 
Images - png folder.
IMPORTANT: FactoryTalk® View application 
renames PNG files when they are imported with a 
.bmp file extension, but the files retain a .png 
format.

All .png files in the HMI FactoryTalk® View 
Images - png folder.
IMPORTANT: FactoryTalk® View application 
renames PNG files when they are imported with a 
.bmp file extension, but the files retain a .png 
format.

Common icons that are used in the Global Objects 
and standard displays for all objects.

Global objects (.ggfx)

(raC-12-ME) Graphic Symbols - Network 
Device.ggfx

(raC-12-SE) Graphic Symbols - Network 
Device.ggfx

Graphic symbols or launch buttons used to open 
faceplate displays from other displays.

(raC-12-ME) Toolbox - Network Device.ggfx (raC-12-SE) Toolbox - Network Device.ggfx Common objects used across multiple device 
faceplates.

Standard displays (.gfx) (raC-12_02-ME) precedes name of the display. (raC-12_02-SE) precedes name of the display. e.g. (raC-12_02-SE) raC_Dvc_S5700-
Faceplate.gfx
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Basic Faceplate Attributes Faceplates consist of tabs, and each tab consists of one or more pages. The 
Home tab is displayed when the faceplate is initially opened. The faceplate 
provides the means for operators, maintenance personnel, engineers, and 
others to interact with a device or instruction instance, which includes a view 
of its status and values. Faceplates may also manipulate an instruction through 
its commands and settings. Select the appropriate icon on the left of the 
faceplate to access a specific tab. This section provides an overview of the 
faceplate attributes that are common across the objects. More details are 
supplied in the individual section for each object.

Common Status Banner

At the top of all device object faceplates there is a common status banner which 
provides the following information:

• Ready (green LED icon) or Not Ready (yellow LED icon) status
• Faulted (banner will show Not Ready with fault message)
• Communication Loss

Display Type View Designer Screen Description

Screen Toolbox Graphic symbols or launch buttons used to open faceplate/pop-up displays from other 
displays.

Pop-Up raC_Dvc_ precedes name of the pop-up. Faceplate display for specific device. e.g. raC_Dvc_S5700_FP

61

2

3 4

2

5

Item Description
1 Ready state displays green LED icon and grey background.
2 Faulted state shows yellow LED icon and Not Ready status.
3 Fault message for latest fault present.
4 Fault reset button
5 Add-On Instruction not enabled status
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Faceplate Navigation

All device object faceplates have navigation tabs on the left side of the 
faceplate. Navigation tabs may vary based on device type. The active tab will 
show as a light grey, while an inactive tab will show as a dark grey.

The common tabs are shown below.

Faceplate Revision Notes By clicking on the open space near the bottom left corner of the faceplate you 
can momentarily view revision notes and details of the active faceplate. This 
may be useful in troubleshooting or when communicating with Rockwell 
Automation® Tech Support.

Active Tab Inactive Tab

Home Tab

Port Details Tab

Switch/Node Tab

Fault Tab

Ring Tab

 

2

1

3

4

Item Description
1 Click near the bottom right corner to temporarily open up the revision notes dialogue
2 Revision number
3 Faceplate display name
4 Close revision information button
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Library Versions Each library object has a revision x.yy where: x is the Major Revision number 
and yy is the Minor Revision number. Each release of the library comes with 
release notes that describe the changes that were made since the last release. 
You can find the revision number of the object in a number of locations as 
shown below.

Component Example

The Add-On Instruction in Logix Designer 
application has revision information visible 
when the instruction is selected in the 
Controller Organizer.
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State Model The following section will discuss the state model for Device Object. The figure 
below shows the core logic states.

By default, each state is active for a minimum of 256us to allow for evaluation 
of state outside of the ADO   instance in the user program

The Add-On Instruction Definition General 
tab shows the revision number along with 
basic revision notes. Refer to the release 
notes for complete revision notes.

The faceplate in FactoryTalk® View 
software has revision information visible 
when the pointer is clicked just inside the 
lower left corner of the faceplate.

The revision number is shown in the file 
names for GFX, VPD, ACM.HSL4, AOI.L5X, 
and RUNG.L5X files.

Component Example
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Interfaces Device object interfaces are intended to provide the application programmer a 
class based harmonized interface for interacting with the device object from 
user code. Standard control interfaces are used for passing device inputs (Inp), 
device configuration (Cfg), Settings (Set), Commands (Cmd) and Status (Sts). 

In the Network Device Library, only a Status (Sts) interface is provided for the 
raC_Dvc_StratixAll object. This interface called Ref_Ctrl_Sts provides status 
information for the object such as connected, warning and fault statuses. The 
data-type used is raC_UDT_ItfAD_Stratix_Sts. This common interface allows 
you to easily switch between Stratix® switch devices without having to update 
user code. For complete information on this interface, please refer to the 
raC_Dvc_Stratix® section of this manual.

Application Code Manager Architectural Overview

Device libraries, as with most Application Code Libraries are divided into 2 
logical groups: either Asset-Control Object or Device Implement Object.
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Asset-Control Objects contain the asset definition of an object and any 
associated content which belongs to the asset. This includes controller tags, 
add-on instructions, data types, and attachments such as HMI content and 
documentation. These are found under the (RA-LIB) Device > Asset-Control 
folder and have names like raC_Dvc_xxxx where xxxx is the device name.

Device Implement Objects contain an instance of an asset-control object and 
provide all related configuration of the asset. The Device implement type is the 
application code (e.g. programming rung). This includes the required 
controller tags, programs, modules, and FactoryTalk® View ME/SE symbols. 
These are found under the (RA-LIB) Device > Device folder and have names like 
raC_LD_Dvc_xxxx where xxxx is the device name. LD stands for ladder logic.
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Using the Library

Install the Library Download the Library

For the latest compatible software information and to download the Rockwell 
Automation® Library, see the Product Compatibility and Download Center.

Search “Device Library” or filter on Application Content to quickly find the 
library.

Download & Install Studio 5000® Application Code Manager

Studio 5000® Application Code Manager is free to install from Rockwell 
Automation’s Product Compatibility and Download Center.

Search “Application Code Manager” and select the item to download. 

https://compatibility.rockwellautomation.com/Pages/home.aspx#/scenarios
https://compatibility.rockwellautomation.com/Pages/home.aspx#/scenarios


30 Rockwell Automation Publication DEVICE-RM400B-EN-P - January 2024

          Using the Library

Extract the downloaded .zip file by running the 4.xx.00-Studio5000_ACM-
DVD.exe executable file. This will extract a new folder containing a Setup.exe file 
which can be run to begin product installation.

Follow the prompts from the splash screen until installation is complete. Note 
that a SQL server is required for Application Code Manager. SQL Server 
Express is offered for free and is included in the Application Code Manager 
installer.

Register Libraries in Studio 5000® Application Code Manager

It is recommended that you use Studio 5000® Application Code Manager or 
the Studio 5000® “Import Library Objects” Plug-In Wizard to import device 
library objects into a Logix 5000 controller project. To use the library in 
Application Code Manager you must first register the libraries.

Using Studio 5000® Application Code Manager is not mandatory although it is highly 
recommended to reduce the likelihood of configuration errors and simplify the 
workflow. Alternatively, you can import the RUNG.L5X files directly into a Studio 
5000® project.

The Lite version of Studio 5000® Application Code Manager is free of charge and can 
be downloaded from the Product Compatibility and Download Centre. None of the 
features included in the Standard (paid) version are required to use Device Object 
Libraries.
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Register Complete Library Automatically

To automatically register the entire library, find and run the setup.cmd file in 
the root folder of the library files. You will see a windows console appear as the 
script runs. When it is complete it will display “Deployment Complete”. Enter 
“Y” to exist the console.

Register Individual Library Objects Manually

As an alternative to registering the entire library using the setup.cmd script, 
you can manually register one or multiple library objects in Studio 5000® 
Application Code Manager. Open up Application Code Manager and view the 
Registered Libraries panel on the right. Right-click on Registered Libraries and 
select Register. Browse to the ApplicationCodeManagerLibraries folder within the 
library files and select any HSL4 files that you would like to register. Note you 
may select more than one at a time. Once you complete registering the desired 
objects they will be shown under the (RA-LIB) Device solution folder.

Message Paths CIP message paths must be defined as strings in all DLR objects to 
communicate with the network. This includes the following parameters:
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CIP paths are written using a combination of numbers for ports and slots from 
the current device to the destination device. For DLR paths you can point the 
message to any module on the Ring. For simplicity in most cases we use the 
most immediate module on the ring such as the 1756-EN2TR module, 
embedded Ethernet port, or ETAP device. 

Message paths generally follow three possible structures:
• Controllers with an in-chassis Ethernet Module or ETAP: 

1,Slot#,2,IPAddress
- 1: Backplane from this controller
- Slot#: Slot number which the in-chassis Ethernet module is located
- 2: Ethernet Network
- IPAddress: IP Address of any device on the network. Generally this is 

set to the IP address of the Ethernet module (e.g. 1756-En2TR) or 
ETAP which is first connected to the DLR network.

• Controllers with an Embedded DLR Ethernet Ports: 2,IPAddress
- 2: Ethernet Network
- IPAddress: IP Address of any device on the network. Generally this is 

set to the IP address of the the controller’s embedded DLR ports.
• CompactLogix 5380 controllers with Ethernet Ports in Dual-IP mode: 

3,IPAddress or 4,IPAddress
- 3 or 4: Ethernet Network. Use 3 for port A1; Use 4 for port A2.
- IPAddress: IP Address of any device on the network. Generally this is 

set to the IP address of the the controller’s embedded DLR ports.

Examples are shown below.

Message Path Example 1 - ControlLogix® with Dual-Port Ethernet 
Module

For ControlLogix® with EN2TR/EN3TR/EN4TR module with IP address 
192.168.1.3 in slot 2 directly connected to the DLR network:

Message Path: 1, 2, 2, 192.168.1.3 

Instruction Message Path Parameter Description
raC_Opr_NetDLR1 Ref_Path_to_DLR Path to any module on Ring
raC_Opr_NetDLR1_Lite Ref_Path_to_DLR Path to any module on Ring

raC_Opr_NetDLR3_RingOfSwitches

Ref_Paths.Ref_Ring1_Path Path to any module on Ring 1
Ref_Paths.Ref_Ring2_Path Path to any module on Ring 2
Ref_Paths.Ref_Ring3_Path Path to any module on Ring 3
Ref_Paths.Ref)Switch_Paths[10] CIP Paths to Stratix Switches

Item Description
1 Backplane of this controller 1756-L8x
2 Slot 2 - 1756-EN2TR Ethernet module connected to DLR network
2 Ethernet Network
192.168.1.3 IP Address of 1756-EN2TR ethernet module 
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Message Path Example 2 - CompactLogix® 5370 with Dual-Ports

For CompactLogix® with embedded dual Ethernet Ports and an IP address of 
192.168.1.18 directly connected to the DLR network:

Message Path: 2, 192.168.1.18 

Message Path Example 3 - CompactLogix® 5370 with ETAP

For a legacy CompactLogix® with a single Ethernet Port where an ETAP with IP 
address of 192.168.1.12 is used to connect to the DLR network:

Message Path: 1,1,2, 192.168.1.12 

Item Description
2 Ethernet Network (Direct from embedded Ethernet port)
192.168.1.18 IP Address of CompactLogix ®Embedded Ethernet port



34 Rockwell Automation Publication DEVICE-RM400B-EN-P - January 2024

          Using the Library

Message Path Example 4- ControlLogix® with Single-Port Ethernet 
Module

For a ControlLogix® with a single-port Ethernet module (1756-EN2T/1756-
ENBT) in slot 3 and an ETAP with IP address of 192.168.1.12 is used to connect 
to the DLR network:

Message Path: 1,3,2, 192.168.1.12 

Item Description
1 Backplane of this controller
1 Slot 1 - Ethernet port is always in slot 1
2 Ethernet Network (Direct from embedded Ethernet port)
192.168.1.12 IP Address of ETAP device

Item Description
1 Backplane of this controller
3 Slot 3- EN2T Module Slot
2 Ethernet Network 
192.168.1.12 IP Address of ETAP device
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Message Path Example 5 - CompactLogix® 5380 with Ports in DLR Mode

For a CompactLogix® with the Ethernet ports set to DLR mode with an IP of 
192.168.1.23 connected directly to the DLR network:

Message Path: 2, 192.168.1.23 

Message Path Example 6- CompactLogix® 5380 with Ports in Dual IP 
Mode

For a CompactLogix® with the Ethernet ports set to Dual IP mode connected to 
the DLR network via an ETAP with an IP of 192.168.1.27:

Message Path using port A1: 3, 192.168.1.27 

Item Description
2 Ethernet Network 
192.168.1.23 IP Address CompactLogix®
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Message Path using port A2: 4, 192.168.1.27

Importing Logic into Studio 
5000® Projects

There are multiple methods to using the logic in a Studio 5000® application. 
For projects that are being developed from scratch using Studio 5000® 
Application Code Manager along with other Application Code Libraries such as 
the PlantPAx® Process Objects Library or the Machine Builder Library, you can 
continue to use the Device Object Libraries in Application Code Manager. For 
existing applications where devices are being added, it is recommended to use 
the Studio 5000® Plug-In “Import Library Objects” Wizard. Alternatively you 
can import the RUNG.L5X files into your program and configure them 
manually.

Below is a table to capture recommendations on when to use which tool or 
workflow when importing and configuring device objects.

Item Description
3 or 4 Embedded Ethernet Network. Use 3 for port A1. Use 4 for port A2.
192.168.1.27 IP Address CompactLogix®

In the Library there is a folder named Videos which contains many How-To and 
Operational Overview Videos which walk step-by-step through each process. You 
can refer to the following videos for this section: 
“How_To_Import_and_Configure_Stratix_Switch_Device_Objects_in_Logix_Designer” 
“How To Import and Configure Single DLR Object Components in Logix Designer”
“How To Import and Configure Three DLR Object Components in Logix Designer”

It is not recommended to simply import the AOI.L5X files and attempt to build your 
own logic rung. Doing so will increase the likelihood of configuration errors and likely 
miss logic that is required outside of the Add-On Instruction.
AOI files should only be imported when updating an existing application from a 
previous version of a Device Object Library to a newer one.
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Import Library Objects Wizard

The most simple way to import a Device Object into an existing application is 
to use the Studio 5000® Plug-In “Import Library Objects” wizard. This plug-in 
requires Application Code Manager to be installed but does not require it to be 
open or have a project created.

Right click on an item (e.g. Controller, Task, Program, etc) in the Controller 
Organizer and select Plug-Ins > Import Library Objects...

This will launch a small wizard version of Application Code Manager inside of 
your Studio 5000 Logix Designer® Project. In the Registered Libraries panel on 
the left, find your desired object under Registered Libraries > (RA-LIB) Device > 
Device and drag it into the Library Object(s) list in the Object Configuration 
Tab.

Tool/Workflow Description of when to use Software Requirements
Studio 5000® Application Code 
Manager
(full application)

Project is developed from scratch using 
Application Code Manager along with 
PlantPAx® or Machine Builder libraries.

Studio 5000 Logix Designer®
Studio 5000® Application Code Manager 
(Lite)

Studio 5000® Plug-In “Import 
Library Objects” Wizard

Application Code Manager is installed but 
not required for the entire project. 
Application has already been developed 
but some Device Objects need to be 
added.

Studio 5000 Logix Designer®
Studio 5000® Application Code Manager 
(Lite)

Import RUNG.L5X File

Application Code Manager is not installed. 
Application has already been developed 
but some Device Objects need to be 
added.
Familiar with rung import workflow.

Studio 5000 Logix Designer®

Import AOI.L5X File
Updating existing application that 
contains an older version of a Device 
Object AOI.

Studio 5000 Logix Designer®
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Stratix® Configuration

Perform the following configuration:

Parameters - 00 General:
• Enter a name and description. Maximum name length can be 22 

characters. Note that other parameters such as the RoutineName, 
TagName, etc will auto-complete based on these fields.

• Assign the Task and Program.

Parameters - 01 Module:
• You can choose to automatically create the Stratix® switch module in 

your program if not already included by setting IncludeHW to True.
• Assign the desired ModuleName, ModuleType, CatalogNo for the 

hardware.
• Assign a unique IPAddress.
• Set the ParentModule to the name of the Ethernet communications 

adapter that the switch is connected to. If using the embedded 
Ethernet port on a 5580 controller then leave this as Local. Note that this 
may show a red ‘X’ next to the name even though the program will be 
correctly generated and compile.

Parameters - HMI Configuration:
• The HMI Configuration options are not used in the Plug-In Wizard and 

can be ignored.

Linked Libraries:
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• Click next or click on the Linked Libraries tab. Click the Auto Create 
button to automatically create all of the required linked libraries.

Complete the Import:
• On the following screen you can select the desired Merge Actions. 

Generally these can be left with the default actions.
• Add: used when AOIs don’t previously exist in application
• Overwrite: usually preferred. Used when AOIs previously exist but 

may or may not be the same revision.
• Use Existing: used when AOIs previously exist in the application and 

you do not wish to overwrite the existing items.
• Click next and you can now see any new logic and modules that will be 

created.
• Click Finish to complete the import.

DLR Configuration

DLR configuration will vary slightly depending on whether DLR1, DLR1_Lite or 
DLR3 objects are used.

Parameters - 00 General:
• Enter a name and description. Maximum name length can be 22 

characters. Note that other parameters such as the RoutineName, 
TagName, etc will auto-complete based on these fields.

You can manually create new linked libraries or point to existing linked libraries if 
necessary. You may need to do this if you would like to use an older version of library 
objects when multiple versions are installed in Application Code Manager.



40 Rockwell Automation Publication DEVICE-RM400B-EN-P - January 2024

          Using the Library

• Assign the Task and Program.
• Set the Ref_Paths parameter to the CIP path of the DLR node (e.g. 

1,2,2,192.168.1.3). See Message Paths for more information and 
examples on assigning this string. 

• Note that the DLR3 object can have paths to a maximum of three rings 
as well as paths to two switches.

Parameters - HMI Configuration:
• The HMI Configuration options are not used in the Plug-In Wizard and 

can be ignored.

Linked Libraries:
• Click next or click on the Linked Libraries tab. Click the Auto Create 

button to automatically create all of the required linked libraries.

Complete the Import:
• On the following screen you can select the desired Merge Actions. 

Generally these can be left with the default actions.
• Add: used when AOIs don’t previously exist in application
• Overwrite: usually preferred. Used when AOIs previously exist but 

may or may not be the same revision.
• Use Existing: used when AOIs previously exist in the application and 

you do not wish to overwrite the existing items.
• Click next and you can now see any new logic and modules that will be 

created.
• Click Finish to complete the import.

Import Rung Logic

An Add-On Instruction is defined once in each controller project, and can be 
instantiated multiple times in your application code. To use pre-engineered 
logic, import each desired RUNG.L5X file into a controller project. The process 
is similar for both Stratix® switch and DLR objects.

1. In the Studio 5000 Logix Designer® application, open a new or
existing project.

2. Choose or create a new ladder routine to open. Right-click in the 
routine ladder and choose Import Rungs... 

You can manually create new linked libraries or point to existing linked libraries if 
necessary. You may need to do this if you would like to use an older version of library 
objects when multiple versions are installed in Application Code Manager.

IMPORTANT Add-On Instruction definitions can be imported, but not updated, online.
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3. Select the desired RUNG and Select Import. The file will have a name 
like raC_Dvc_Stratix_12.02_RUNG.L5X. 

.

4. An Import Configuration dialogue window will open and display generic 
Import names which include “_InstanceName”. Click the Find/Replace... 
button and replace all instances of “_InstanceName” with your desired 
device name (e.g. “Switch_Panel100”).

Both “RUNG” and “AOI” .L5X files are provided. Import the RUNG 
file to get all required additional tags, data types, and message 
configurations.
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5. For Stratix® switch objects, click on the Other Components section to set 
the ModuleName. Type or browse to the name of the Stratix® Switch 
module. In this example our module is called “Dvc_Switch_Panel100”. 
This step is not required for DLR objects.

6. The rung will now be imported into your ladder routine.
7. For DLR objects you will need to manually set-up the paths to the DLR 

rings (and up to two switches for DLR3). In the imported rung, right-
click on the _InstanceName_Paths tag and select monitor.
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See Message Paths for more information and examples on assigning this 
string. 

Using Studio 5000 View 
Designer®

Using Studio 5000 View Designer® Project Files

Studio 5000 View Designer® may be used for HMI development for 
PanelView™ 5000 applications. Open up your Studio 5000 View Designer® 
project alongside a second application instance running the required VPD file 
in the library folder HMI - ViewDesigner - vpd.

You will notice there are two screens available under the User-Defined Screens 
folder:

• Screen_001: This has the graphic symbol launch buttons for the 
faceplate.

• raC_Dvc_xxxxx_FP: This is a faceplate pop-up screen.

In the Library there is a folder named Videos which contains many How-To and 
Operational Overview Videos which walk step-by-step through each process. You 
can refer to the following videos for this section: 
“How_To_Import_and_Configure_Stratix_Switch_Device_Objects_in_ViewDesigner” 
“How To Configure DLR Object Components in View Designer”
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To include these files in your project, perform the following steps:
• Copy the entire faceplate _FP screen from the supplied VPD project to 

your project application.
• Open the Screen_01 screen and copy the desired graphic symbol and 

paste it into a screen in your project application.

Configuring View Designer Objects

For text based buttons, you can assign the text shown on the button by 
highlighting the button. View the Properties tab and modify the General > Text 
parameter as required.

To link the launch button to the faceplate, highlight the button and view the 
Events tab of within the Properties pane. If not already configured, set an Event 
to Open popup on release with the following settings:

• Key: Touch Only
• Popup: Select desired faceplate screen
• Stratix/AOI_Tag: Browse to AOI backing tag for the device object in 

your controller file
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Using FactoryTalk® View 
Studio

Import FactoryTalk® View Visualization Files 

There are several components to import for the visualization files. You import 
files from the downloaded Rockwell Automation® library files via FactoryTalk® 
View ME or FactoryTalk® View SE. The workflow is the same for both 
FactorTalk View ME and SE. 

All image and display items can be imported either by right-clicking in 
FactoryTalk® View on the Graphic sub-folder (e.g. Displays, Global Objects, 
Images) or simply dragging and dropping the files into the application.

Import files in this order:
1. Import HMI Images files.

Select all the images in the \HMI FactoryTalk® View Images - png folder 
and Open.

In the Library there is a folder named Videos which contains many How-To and 
Operational Overview Videos which walk step-by-step through each process. You 
can refer to the following videos for this section: 
“How_To_Import_and_Configure_Stratix_Switch_Device_Objects_in_FTViewME” 
“How_To_Import_and_Configure_Stratix_Switch_Device_Objects_in_FTViewSE”
“How To Import and Configure DLR Object Components in FTView ME”
“How To Import and Configure DLR Object Components in FTView SE”
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2. Import Global Object files

Select the global object (.ggfx) files from the \HMI - FactoryTalk® View 
ME\Global Objects - ggfx or \HMI - FactoryTalk® View SE\Global Objects - 
ggfx folder

3. Import HMI Faceplates

Select the faceplate (.gfx) files from the \HMI - FactoryTalk® View ME\Displays - 
gfx or \HMI - FactoryTalk® View SE\Displays - gfx folder

Configuring FactoryTalk® View Objects

Once the files have been imported into the FactoryTalk® View Studio project, 
you can begin using them in your application. Open the Global Display (raC-12-
ME) Graphic Symbols - Network Device. Copy the desired launch button style and 
paste it into a display in your application where you would like to open the 
faceplate. For more information on graphic symbols, refer to the Graphic 
Symbols section of the specific device type chapter in this manual.

To configure the graphic symbol launch button, right-click and select Global 
Object Parameter Values. The Global Object Parameter value for the Backing Tag 
(#102) is mandatory while the custom Navigation Button Label (#104) and 
display position values (#120, #121) are optional. If you do not enter in a custom 
text label it will by default show the AOI’s .@Description field. You can browse 
for the tag in your controller project by clicking ‘...’ or manually type them in. 
These parameters may vary depending on the graphic symbol used, please 
refer to the Graphic Symbols section of the device type for detailed 
information.

These Global Object Parameter Values are automatically configured when you use 
Studio 5000® Application Code Manager to design and configure your project. Refer 
to Using Studio 5000® Application Code Manager for more information.
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Library Upgrades Add-On Instruction Upgrades

There are two methods to upgrading existing device object add-on 
instructions in a project. You can do this either by using the Studio 5000® Plug-
In Import Library Objects Wizard or by importing individual add-on instruction 
AOI.L5X files. Both methods are described in the following sections.

Note that all updates to Add-On Instructions must be done with Studio 5000 
Logix Designer® in OFFLINE mode and a download to the controller is 
required.

Upgrades Using Studio 5000® Plug-In to Import Library Objects

If Studio 5000® Application Code Manager is installed, you can use the Studio 
5000® Plug-In Import Library Objects Wizard to update existing Add-On 
Instructions. For complete information on Studio 5000® Application Code 
Manager, refer to the section Using Application Code Manager.

Right-click in your controller organizer or within a routine to access Plug-Ins > 
Import Library Objects...

The Library Object Import Wizard dialogue window will open. Under Registered 
Libraries expend (RA-LIB) Device > Asset-Control and find the desired object and 
version. Drag the object into the Object Configuration window on the right.
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In the Merge Actions window, select the Action for the AddOnIntructionDefinition 
to Overwrite. This will update any existing instance of the object to the newer 
version. You may also choose to overwrite any other DataTypes or Tags. Review 
the release notes of the latest library release to understand what may be 
impacted. Click next and finish to complete the process.
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Upgrades by Importing AOI.L5 X Files

To upgrade or migrate a project that uses a previous library version to a newer 
one, the add-on instruction L5X files are supplied. To perform an upgrade to 
an object perform the following steps:

• Open the controller file. Note changes must be done offline.
• In the Controller Organizer pane right-click on Assets > Add-On Instructions 

and select Import Add-On Instruction. Navigate to the AOI.L5X file in the 
Studio 5000 Logix Designer Files - L5X and Open.

• You will be prompted that there is an existing version of the instruction 
that is different. Choose Overwrite as the operation. 
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• If the Red flag exist in the References. e.g.
a. In Data Type: Wherever it shows Differences, we must select 

Overwrite operation.
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b. Add-On Instructions: For all Add-On Instruction select Overwrite 
option.

• Select OK once you have read and understood the warnings. Your 
existing logic will be updated with the new add-on instruction. Verify 
that your code compiles and test adequately.

• After compilation if there is an error with the "Ref_Ctrl_Sts" parameter, 
it is necessary to manually modify the Data type of each instance of the 
"Ref_Ctrl_Sts" parameter to the new data type 
"raC_UDT_ItfAD_Stratix_Sts." 

• In order to ensure the HMI faceplate still works properly you will need 
to update the object’s library information stored in the Inf_Lib tag. In 
the Controller Organizer pane under Assets > Add-On Instructions expend 
the device object that was updated. Double-click on Parameters and Local 
Tags to open up the instructions tags.
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• In the Add-On Instruction Parameters and Local Tags window, you may 
notice that the Inf_Lib tag in the add-on instruction definition matches 
the new library revision number. Click on the down-arrow to the right 
of the copy button and select Copy Specified Values...

• In the Copy Default Values window, be sure to first uncheck all 
Parameters and Local Tags by clicking the +/- box in the top right. 
Failure to do so may result in overwriting settings in the existing 
objects.

• Check only Inf_Lib in the Local Tag area. On the right, all affected objects 
should be selected. Click OK.

• You can now confirm that the Inf_Lib tag has been updated to the 
current library (e.g. ‘raC-12_02’) by changing the Data Context drop-
down to a specific device object.
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FactoryTalk® View Upgrades

To upgrade a device object in a FactoryTalk® View ME/SE application, simply 
import the new faceplate .gfx display file into the application. If any global 
objects or images have been added or modified, you may need to import these 
as well. Any unused displays from previous versions may be removed or 
deleted from the application.

Note that the reference to the faceplate version is set in the Add-On 
Instruction Local Tag Inf_Lib so there does not need to be other modifications 
to the HMI application.

Studio 5000 View Designer® Upgrades

To upgrade a device object in a Studio 5000 View Designer® application, 
simply import the open the new View Designer .vpd file and copy the 
raC_Dvc_xxxxx_FP pop-up screen into the existing application. Find any 
graphic symbol launch buttons in the application that open the faceplate, and 
update the Action to open the new pop-up screen. Any unused pop-up screens 
from previous versions may be removed or deleted from the application.
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Chapter 4

Using Application Code Manager

Overview of Application 
Code Manager

Studio 5000® Application Code Manager is a tool that enables more efficient 
project development with libraries of reusable code. Application Code 
Manager creates modular objects with customizable configuration parameters 
using the reusable content. Application Code Manager can also create the 
associated visualization, historical and alarming elements for a project.

Studio 5000® Application Code Manager can be easily used along with 
Rockwell Automation® application code libraries such as the PlantPAx® 
Process Objects Library, Machine Builder Library, and Device Object Libraries. 
For more information on Studio 5000® Application Code Manager, refer to the 
Application Code Manager User Manual.

Creating a New Project Begin by opening Application Code Manager.

Note: the last project (if any) is opened by default; otherwise a blank screen is 
displayed.

Create a New Project or open an existing project. Navigate to File > New > 
Project.

 

 

https://literature.rockwellautomation.com/idc/groups/literature/documents/um/logix-um003_-en-p.pdf
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Select the desired project type (e.g. (RA-LIB) ACM 2.00 Project - Basic_Project) 
and fill in the Name and Description.

To add a new controller to a project, in the Controller Preview window, right-
click on Controllers and select Add New...

Select the desired controller type (e.g. ControlLogix®_Controller, 
GuardLogix_Controller, CompactLogix_Controller, etc). Enter a Name and 
Description for the controller. Select the appropriate Chassis and Processor 
configurations.

You can also configure the HMI AreaPath and.or AreaPathME parameters which 
will be referenced if you use Application Code Manager to generate 
FactoryTalk® View ME/SE displays with graphic symbol launch buttons.



Rockwell Automation Publication DEVICE-RM400B-EN-P - January 2024 57

          Using Application Code Manager

You can now add in any desired tasks and programs to your controller. Right-
Click on the Tasks folder underneath your controller in the Controller Preview 
and Add New Task. Similarly, right-click on any Task and select Add New 
Program. Complete the desired parameters for Tasks and Programs such as 
name, type, period, etc.
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Adding & Configuring Device 
Objects

Prior to adding in any Device Objects, ensure you have registered the library in 
Application Code Manager. Refer to Registering Libraries in Studio 5000® 
Application Code Manager for details.

Adding Stratix Device Instructions

To add a Device Object into a project, right-click on a Program and Add New...

• In the Object Configuration Wizard dialogue window you can click on the 
Category heading to group objects by category and find Network. Select 
the desired Network object with Library Type Device (e.g. 
raC_LD_Dvc_Stratix) and click Next. 

• Fill in all of the required configuration parameters for the device object. 
The following example shows a configuration of the 
raC_LD_Dvc_Stratix object.

Perform the following configuration:
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Parameters - 00 General:
• Enter a name and description. Maximum name length can be 22 

characters. Note that other parameters such as the RoutineName, 
TagName, etc will auto-complete based on these fields.

• Assign the Task and Program.

Parameters - 01 Module:
• You can choose to automatically create the Stratix® switch module in 

your program if not already included by setting IncludeHW to True.
• Assign the desired ModuleName, ModuleType, CatalogNo for the 

hardware.
• Assign a unique IPAddress.
• Set the ParentModule to the name of the Ethernet communications 

adapter that the switch is connected to. If using the embedded 
Ethernet port on a 5580 controller then leave this as Local. Note that this 
may show a red ‘X’ next to the name even though the program will be 
correctly generated and compile.

Parameters - HMI Configuration:
• Navigation Button: Choose Icon or Text type navigation button.
• For HMI Configuration refer to Configuring Displays. 

Linked Libraries:
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• Click next or click on the Linked Libraries tab. Click the Auto Create 
button to automatically create all of the required linked libraries.

• Click Finish to complete the object configuration.

For specific devices details, refer to the appropriate chapter in this manual.

Adding DLR Device Object

To add a DLR Object into a project, right-click on a Program and Add New...

In the Object Configuration Wizard dialogue window you can click on the 
Category heading to group objects by category and find Network. Select the 
desired DLR object of type Device (e.g. raC_LD_Opr_NetDLR1, 
raC_LD_Opr_NetDLR1_Lite, or raC_LD_Opr_NetDLR3) and click Next.

You can manually create new linked libraries or point to existing linked libraries if 
necessary. You may need to do this if you would like to use an older version of library 
objects when multiple versions are installed in Application Code Manager.
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• Fill in all of the required configuration parameters for the device object. 
The following example shows a configuration of the 
raC_LD_Opr_NetDLR1 object.

Perform the following configuration:Parameters - 00 General:
• Enter a name and description. Maximum name length can be 22 

characters. Note that other parameters such as the RoutineName, 
TagName, etc will auto-complete based on these fields.

• Assign the Task and Program.
• Set the Ref_Paths parameter to the CIP path of the DLR node (e.g. 

1,2,2,192.168.1.3). See Message Paths for more information and 
examples on assigning this string. 

• Note that the DLR3 object can have paths to a maximum of three rings 
as well as paths to two switches.

Parameters - HMI Configuration:
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• Nodes (DLR1 only): Choose 24Node or 56Nodes as the maximum network 
size to assign the appropriate HMI display.

• For HMI Configuration refer to Configuring Displays. 

Linked Libraries:
• Click next or click on the Linked Libraries tab. Click the Auto Create 

button to automatically create all of the required linked libraries.

• Click Finish to complete the object configuration.

For specific devices details, refer to the appropriate chapter in this manual.

You can manually create new linked libraries or point to existing linked libraries if 
necessary. You may need to do this if you would like to use an older version of library 
objects when multiple versions are installed in Application Code Manager.
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Configuring Displays Application Code Manager can be used to automatically configure graphic 
symbol launch buttons for device objects In FactoryTalk® View ME or SE. Note 
that Application Code Manager is not compatible with Studio 5000 View 
Designer® applications. 

First you must add Displays to your project. Under the System View panel 
expand HMI and right-click on Displays to select Add. Choose the type of 
display (e.g. FTViewME or FTViewSE depending on your project requirements.

In the display object parameter configuration, you must select the 
DisplayTemplate type to match the version of FactoryTalk® View application 
that you are using.
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Navigate to the Displays tab where you can right-click and Add New display.

Set the desired name and display parameters. Generally all display parameters 
aside from Name can be left as default since this will often be used as a 
temporary display where object launch buttons are copied from.

Return to your device object configuration and view the HMI Configuration 
section of the parameters. You can browse or type in the 
HMI_Server_Name.HMI_Display_Name.
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If you browse for the display, select the desired display server in the left panel, 
then click on the Display tab in the right panel and select the specific display. 
Click finish.

This workflow can be followed for either FactoryTalk® View ME or SE 
depending on the project requirements.

Generating Displays Once you have assigned displays to all of the device objects, you can generate 
the displays. In the System View highlight the desired display server under HMI 
> Display and right-click to select Generate Displays > All Displays or select 
individual displays. Choose a place to save the generated files and take note of 
it.

Importing Displays into 
FactoryTalk® View Studio

To import the configured displays, open your FactoryTalk® View ME/SE 
project in FactoryTalk® View Studio. Right-click on Graphic > Displays and 
select Import and Export...

Follow the required prompts:
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• Import graphic information into displays
• Choose whether or not to backup displays
• Choose either a Single display import file (must have an existing or blank 

display to import into) or Multiple displays batch import file if All Displays 
was used to Generate Displays.

• If this is the first time it is recommended to import Multiple displays 
batch import file and then Create new objects on the display.

• If you have done this before and are updating the imported display 
after modifying your Application Code Manager project, you can 
choose Update existing objects on the display. 

• Browse for the BatchImport.xml file or individual display.xml file.

Open up the newly imported display. Notice that there are graphic symbol 
launch buttons labeled and configured for each item that was configured in 
Application Code Manager.

Right-click on the object and select Global Object Parameters to view that all of 
the parameters have been pre-configured for you.

You may not copy and paste this graphic symbol onto any other display in your 
application.

Generating Controller Files Once you have completed configuring your project in Studio 5000® 
Application Code Manager, you can generate the controller file for use in 
Studio 5000 Logix Designer®.

In the Controller Preview pane right-click on the controller name within the 
Controllers folder and select Generate Controller.
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In the Logix Code Generation dialogue window you will need to check Create 
ACD. You ma also need to check Overwrite Existing if this is not the first time 
generating the controller code.

Once the controller file is generated, you can navigate to the location set in 
Save Path and open your file. Note that all of the configuration that was done in 
Application Code Manager is now shown in your Logix Designer ACD file.

Exporting Attachments Application Code Libraries not only contain Logix code, but also contain 
Visualization collateral and associated documentation. Every Asset library 
contains at least a reference manual (RM). Those libraries which have 
associated Visualization content also have all required global objects (GO), 
images, static displays and View Designer applications added as attachments. 
In this manner the user can generate only the necessary visualization and 
documentation for the objects included in the project.

In Application Code Manager, all of the attachments are associated with the 
device objects in the (RA-LIB) Device > Asset-Control folder. These can be 
accessed both through the full Application Code Manager software, or via the 
Studio 5000® Plug-In “Import Library Objects”.

To access the attached files, right click on the objects (e.g. raC_Dvc_Stratix) 
and select Extract Attached Files.
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Select the destination folder on your computer, and select OK. An Extract 
Attachments dialog will show the extraction status.

The extracted folder will contain the following:
• Reference Manual
• Required Images
• View Designer Faceplate Files
• FactoryTalk® View Machine Edition Display
• FactoryTalk® View Machine Edition Global Objects
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Using the Network Device Library with Other 
Application Code Libraries

Application Code Libraries The Network Device Library is can be used alongside other Application Code 
Libraries. 

The Machine Builder Library and PlantPAx® Process Object Library 
application-level library objects may be used in the same applications with the 
device-level objects in the Network Device Library. At this time there are no 
direct dependencies or interaction points between these libraries. They may be 
used independently from one another but within the same application.

Other libraries utilize the common device interface UDTs to interact with 
device level objects. In the case of the Network Device Library you may 
programmatically reference the Status (Sts) interfaces of the Stratix 
instructions. This is covered in detail in Interfaces section of this document.
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Stratix® Switch (raC_Dvc_Stratix)

Overview The Stratix® Switch device object (raC_Dvc_Stratix) includes HMI faceplates 
for each managed Stratix® switch (2500, 5200, 5400, 5410, 5700, 5800) and 
ArmorStratix™ 5700 switch which displays device information including:

• Port status and diagnostics
• Switch status and diagnostics
• Switch configuration, settings, and port layout
• Fault and alarm status

Functional Description The Stratix® Switch pre-configured Device Objects:
• Collect, Process and Deliver Data between managed switches and 

Application Logic
• Provide Device Status & Diagnostics Faceplates for Machine Startup, 

Commissioning, Operations, and Maintenance 
• Include Common HMI Faceplate Components, Device States, and 

Control Interfaces providing Application Development and Operation 
Efficiency 

All these features provide quick feedback, shorten recovery time, and simplify 
implementation.

Required Files Device Objects include Add-On Instructions (AOIs) and HMI faceplates. The 
revision number (e.g. 1.01) used in filenames can change as new revisions are 
created.

Controller Files

Add-On Instructions are reusable code objects that contain encapsulated logic 
that can streamline implementing your system. This lets you create your own 
instruction set for programming logic as a supplement to the instruction set 
provided natively in the ControlLogix®® firmware. An Add-On Instruction is 
defined once in each controller project, and can be instantiated multiple times 
in your application code as needed.

In the Library there is a folder named Videos which contains many How-To and 
Operational Overview Videos which walk step-by-step through each process. You 
can refer to the following videos for this section: 
“Operational_Overview_Stratix_Managed_Switch_ Faceplates_in_MachineEdition” 
“Operational_Overview_Stratix_Managed_Switch_ Faceplates_in_SiteEdition”
“Operational_Overview_Stratix_Managed_Switch_Faceplates_in_ViewDesigner”
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The Add-On Instruction must be imported into the controller project to be 
used in the controller configuration. These can be imported as Add-On 
Instruction files, or as part of the Rung Import or Import Library Objects 
wizard. 

All Add-On Instruction and Rung Import files can be found in the /Studio 5000 
Logix Designer Files - L5X/ folder in the library. 

FactoryTalk® View HMI Files

FactoryTalk® View ME applications require importing the desired device 
faceplates in addition to all Global Object (ggfx) files and all images located in 
the /HMI FactoryTalk® View Images - png/ folder of the library. FactoryTalk® 
View ME files are stored in the /HMI - FactoryTalk® View ME/ library folder.

Note that a single Add-On Instruction raC_Dvc_Stratix® is common with any of 
the Stratix® models. The HMI faceplate will automatically display the correct 
layout for the device type.

Studio 5000 View Designer® HMI Files

All Studio 5000 View Designer® Files can be found in the /HMI - ViewDesigner - 
vpd/ folder of the library.

Device Compatible
Device Add-On Instruction Rung Import

Stratix® Switch

Stratix® 2500

raC_Dvc_Stratix_12.03_AOI.L5X raC_Dvc_Stratix_12.03_RUNG.L5X

Stratix® 5200
Stratix® 5400
Stratix® 5410
Stratix® 5700
ArmorStratix™ 5700
Stratix® 5800

Device/Item Type Compatible Device FactoryTalk® View ME
Faceplate

FactoryTalk® View SE
Faceplate

Stratix® Switch Display

Stratix® 2500 (raC-12_03-ME) raC_Dvc_S2500-Faceplate.gfx (raC-12_03-SE) raC_Dvc_S2500-Faceplate.gfx
Stratix® 5200 (raC-12_03-ME) raC_Dvc_S5200-Faceplate.gfx (raC-12_03-SE) raC_Dvc_S5200-Faceplate.gfx
Stratix® 5400 (raC-12_03-ME) raC_Dvc_S5400-Faceplate.gfx (raC-12_03-SE) raC_Dvc_S5400-Faceplate.gfx
Stratix® 5410 (raC-12_03-ME) raC_Dvc_S54100-Faceplate.gfx (raC-12_03-SE) raC_Dvc_S54100-Faceplate.gfx
Stratix® 5700
ArmorStratix™ 5700 (raC-12_03-ME) raC_Dvc_S5700-Faceplate.gfx (raC-12_03-SE) raC_Dvc_S5700-Faceplate.gfx

Stratix® 5800 (raC-12_03-ME) raC_Dvc_S5800-Faceplate.gfx (raC-12_03-SE) raC_Dvc_S5800-Faceplate.gfx
Graphic Symbols Global Object All Stratix (raC-2-ME) Graphic Symbols - Network Device (raC-2-SE) Graphic Symbols - Network Device
Toolbox Global Object All Stratix (raC-2-ME) Toolbox -Network Device.ggfx (raC-2-SE) Toolbox -Network Device.ggfx
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Studio 5000® Application Code Manager Files

Studio 5000® Application Code Manager (ACM) can be optionally used if it is 
installed. All devices can be easily registered in the ACM repositories by 
running the setup.cmd file located in the root folder of the library.

Individual HSL4 files are provided as an alternative to running the setup.cmd 
to allow users to manually register specific implementation objects. Each 
object has two files - an Asset Control file and a Device file. The Asset Control 
files include attachments of all required files for that object. The Device files 
are used to actually add that device into a Studio 5000® project and these 
reference the Asset Control files. 

All Studio 5000® Application Code Manager files can be found in the /
ApplicationCodeManagerLibraries/ folder of the library. The files included are as 
follows:

Operations The Network Device objects provide only physical operation mode. There is no 
virtual device mode offered.

Execution

The following table explains the handling of instruction execution conditions.

Device/Item Studio 5000 View Designer® Faceplate
All Stratix® Switch (raC-12_03-VD) raC_Dvc_Stratix.vpd

Implementation 
Object Compatible Device Asset Control File (.HSL4) Device File (.HSL4)

Stratix® Switch

Stratix® 2500

(RA-LIB)_Device_Asset-Control_Network_raC_Dvc_Stratix_(12.3) (RA-LIB)_Device_Device_Network_raC_LD_Dvc_Stratix_(12.3)

Stratix® 5400
Stratix® 5410
Stratix® 5700
ArmorStratix™ 5700
Stratix® 5800

Condition Description

EnableIn False (false rung)
Processing for EnableIn False (false rung) is handled the same as if the device were 
taken out of service by Command. The device outputs are de-energized and the device 
is shown as Program Out of Service on the HMI. All alarms are cleared.

Powerup (prescan, first 
scan)

On prescan, any commands that are received before first scan are discarded. The 
device is de-energized. On first scan, the device is treated as if it were returning from 
Hand command source: the instruction state is set based on the position feedback that 
is received from the device. If the feedback is valid for one position, the device is set to 
that position. If the device does not have position feedback or the position feedback is 
invalid, the device is set to the ‘unknown/powerup’ state.
The command source is set to its default, either Operator or Program (unlocked).
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Postscan No SFC Postscan logic is provided.

Condition Description
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Add-On Instruction I/O Data InOut Data

Input Data

Output Data

Data Types A number of User-Defined Datatypes (UDT) are used in the Network Device 
Library. A full list of the UDTs used with the raC_Dvc_StratixAll object follows:

InOut Function / Description  DataType

Ref_Module Reference to module in I/O tree MODULE

Ref_Ctrl_Sts Network Device Status Interface raC_UDT_ItfAD_ItfAD_Stratix_Sts

Inf_Lookup Code / Description List Entry raC_UDT_LookupMember_STR0082[32]

Ref_GetAllMessage Message used to read complete CIP 
objects. MESSAGE

Ref_GetSingleMessage Message used to read vendor specific 
attributes. MESSAGE

Ref_Storage Stores CIP message data SINT[300]

Input Function/Description DataType

EnableIn Enable Input - System Defined Parameter  BOOL 

Inp_Enable Enable AOI functions. 1 = enabled. BOOL

Output Function/Descritpion DataType

EnableOut Enable Output - System Defined Parameter BOOL

Sts_EN AOI Enabled Status; 1 = enabled. BOOL

Sts_ER Message error bit; 1= Error BOOL

Sts_Connected Device is connected to the Programmable 
Controller BOOL

Sts_Available Device is available for interaction with user code BOOL

Sts_Warning Device warning status: 1 = an active alarm or 
warning exists BOOL

Sts_Faulted Device faulted status: 1 = an active fault exists BOOL

Sts_bNotReady

Bitwise device 'not ready' reason
0: Reserved
1: Device not connected
2: Device not available
3: Device Faulted
4 - 31: Reserved

DINT

raC_Dvc_StratixAll Unique Parameter Name for auto-discovery BOOL

Ref_HMI Alias tag for HMI_Parameters.HMI_Pointer DINT
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The primary UDTs which a user may interact with are defined in more detail 
below.

raC_UDT_ItfAD_Stratix_Sts

This is the Stratix® Common Control interfacing Status tag. By configuring 
these tags, we can read various status from the device like Ready, Connected, 
and Available etc. The below table shows detailed information of members 
used in this UDT tags. 

Refer to the Interfaces section for general information on interfaces. 

User Defined Datatype Description
raC_UDT_Event Event log
raC_UDT_ItfAD_Stratix_Sts Stratix® Device Status Interface
raC_UDT_LookupMember_STR0082 Warning/Fault Code Look-up table member
raC_UDT_StratixEthernetLink Stratix® Ethernet Link Details
raC_UDT_StratixEthernetLinkClass Stratix® Ethernet Link Class Details
raC_UDT_StratixEthernetPort Stratix® Ethernet Port Details
raC_UDT_StratixHMI Stratix® HMI Faceplate Information
raC_UDT_StratixInfo Stratix® Module Information
raC_UDT_StratixInputData Stratix® Module Input Data
raC_UDT_StratixLocalData Stratix® Module Local Data
raC_UDT_StratixPortIndicator Stratix® Port Indicator Status
raC_UDT_StratixPortSelector Stratix® Port Selector Drop-down Menu
raC_UDT_StratixSwitchParameters Stratix® Module Parameters
raC_UDT_StratixTab0_Home Stratix® HMI Faceplate - Home Tab Information
raC_UDT_StratixTab1_Switch Stratix® HMI Faceplate - Switch Tab Information
raC_UDT_StratixTab1_Switch_Config Stratix® HMI Faceplate - Switch Tab - Configuration Information
raC_UDT_StratixTab1_Switch_General Stratix® HMI Faceplate - Switch Tab - General Information
raC_UDT_StratixTab1_Switch_PTPGM Stratix® HMI Faceplate - Switch Tab - PTPGM Information
raC_UDT_StratixTab1_Switch_PTPLOC Stratix® HMI Faceplate - Switch Tab - PTPLOC Information
raC_UDT_StratixTab1_Switch_VLAN Stratix® HMI Faceplate - Switch Tab - VLAN Information
raC_UDT_StratixTab2_Port Stratix® HMI Faceplate - Port Tab Information
raC_UDT_StratixTab2_Port_Media Stratix® HMI Faceplate - Port Tab - Media Information
raC_UDT_StratixTab2_Port_PTP Stratix® HMI Faceplate - Port Tab - PTP Information
raC_UDT_StratixTab2_Port_Stats Stratix® HMI Faceplate - Port Tab - Stats Information
raC_UDT_StratixTab2_Port_Status Stratix® HMI Faceplate - Port Tab - Status Information
raC_UDT_StratixTab2_Port_Threshold Stratix® HMI Faceplate - Port Tab - Threshold Information
raC_UDT_StratixTab3_Alarm Stratix® HMI Faceplate - Alarm Tab Information
raC_UDT_StratixTab3_AlarmGlobal Stratix® HMI Faceplate - Alarm Tab - Global Information
raC_UDT_StratixTab3_AlarmPort Stratix® HMI Faceplate - Alarm Tab - Port - Information
raC_UDT_StratixTCPIPInterface Stratix® TCP/IP Interface Information
STR0016 String
STR0032 String
STR0064 String
STR0128 String
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raC_UDT_Event

raC_UDT_LookupMember_STR0082

Add-On Instructions A number of embedded Add-On Instructions (AOI) are used within the 
raC_Dvc_StratixAll instruction. These are used to convert between datatypes 
and generate values which can be read from the HMI faceplate. The following 
AOIs are included:

Input Description Data Type

eState

Enumerated state value:
0 = Unused
1 = Initializing
2 = Disconnected
3 = Disconnecting
4 = Connecting
5 = Idle
6 = Configuring
7 = Available

DINT

FirstWarning First Warning Event Data raC_UDT_Event

FirstFault First Fault Event Data raC_UDT_Event

eCmdFail
Enumerated command failure code.
0 = Interface Initialization failure code
1 = Operate as Physical Device failure code
2 = Operate as Virtual Device failure code

DINT

bSts Status (Bit Overlay) DINT

Connected 1 = PAC to device connection has been established BOOL

Available 1 = The device is available for interaction with the user program BOOL

Warning 1 = A warning is active on the device BOOL

Faulted 1 = A fault is active on the device BOOL

Member Description Data Type

Type

Event type:
1 = Status
2 = Warning
3 = Fault
4...n = User

DINT

ID User definable event ID. DINT

Category User definable category (Electrical,Mechanical,Materials,Utility,etc.). DINT

Action User definable event action code. DINT

Value User definable event value or fault code. DINT

Message Event message text. STRING

EventTime_L Timestamp (Date/Time format). LINT

EventTime_D Timestamp (Y,M,D,h,m,s,us). DINT[7]

Member Description Data Type

Code Stores the value of device fault code DINT

Desc Stores the Messages related to fault code STRING
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User Defined Datatype Revision Description
raC_Tec_DecToHex 12.02 Converts decimal number to hexadecimal String

raC_Tec_IPtoString_NET 12.02 Converts numerical IP address into user-
readable string

raC_Tec_PortName_NET 12.02 Dynamically generates Stratix® Switch Port 
Name

raC_Tec_UDINT_Display 12.02 Converts Unsigned DINT into two tags to display 
correctly on HMI
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Programming Example Fully configured device on a rung is provided below for reference. 

Note that this programming example is the same code that is imported when 
either importing the supplied rung .L5X files or when using Application Code 
Manager or the Studio 5000® Import Library Objects wizard plug-in.

The following example uses the Stratix® Switch device object named Dvc_S5700 
connected to Stratix® module named Mod_Dvc_S5700.

Graphic Symbols Graphic Symbols are used as launch buttons within HMI applications to open 
up faceplate displays. See Basic Launch Button Attributes section for details on 
configuration and indicators.

FactoryTalk® View ME/SE Graphic Symbols

Studio 5000 View Designer® Graphic Symbols

Graphic Symbol Name Graphic Symbol Description Global Object Parameter Values

GO_LaunchFP

Faceplate navigation button with string tag label.
This launch button graphic object allows the user 
to navigate to the device object faceplate.
The text on the button face is set to the parameter 
#104.

#102: AOI Backing Tag Instance (e.g. 
{::[PAC]Program::IOLinkProgram._InstanceName})
#104: Navigation Button Label
#120: Display’s left position (e.g. 100) (optional)
#121: Display’s top position (e.g. 100) (optional)

Graphic 
Symbol 
Name

Graphic Symbol Description Property Configuration

Launch
The supplied launch button in View 
Designer is used to navigate to the 
faceplate in a user application. 
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Faceplates There are basic faceplate attributes that are common across all instructions. 
See Basic Faceplate Attributes on page 22.

In this document, the faceplate pictures (or snapshots) are of Stratix® 5700 
Faceplate in Studio 5000 View Designer®. All other Stratix® faceplates have 
similar screens, but some faceplates may not have all tabs and pages available 
depending on the features and port layout supported by the specific model.

The faceplate title is linked to _InstanceName.@description, the .@description 
extended tag property of the Add-On Instruction instance. This is user-
configurable from controller/program tags in Studio 5000 Logix Designer®.

Home

The Home tab is the main tab of the faceplate. It provides the status of the 
Network device along with sensor process data and the Locate button. 

1

7

6

2

5

3
4

Item Description
1 Banner- Ready Status
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Switch Tab

The Switch tab provides switch details on multiple pages. A drop-down 
selector is used to navigate between pages of data including:

• General
• Configuration
• VLANs
• Time Sync

Each selection is described in the following sections

2

Port Status Indicators

GREEN = Link Active

GREY with dark lines = Link Inactive

YELLOW =Port Alarm/Fault

GREY with light lines = Port Disabled

3 Host Name
4 IP Address
5 Switch Uptime

6
SD Card Status
ON/Blue LED = SD Card is present
OFF/Grey LED = SD Card is not present

7
Power supply A & B Status
ON/Blue LED = Power supply is connected
OFF/Grey LED = Power supply is not connected

Item Description
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Switch Tab - General

Switch Tab - Configuration

 

1

2
3
4
5

6

7
8
9

Item Description
1 Switch Details Drop-Down Menu:
2 Model Number
3 Serial Number
4 Software Version
5 CIP Revision
6 Firmware Type: Full/Lite
7 PTP: Precision Type Protocol Supported/Not Supported
8 NAT: Network Address Translation Supported/Not Supported
9 DLR: Device Level Ring One Ring/Three Ring/Not Supported

 

1

2
3
4
5

6

7
8
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Switch Tab - VLAN

Switch Tab - Time Sync

The Time Sync section displays current information about the real-time clocks 
in the network. The data is only displayed if the CIP (Common Industrial 
Protocol) Sync Time Synchronization feature is enabled and the time sync 
information is available for Grandmaster & local Clock

Item Description
1 Switch Details Drop-Down Menu
2 IP Address
3 Subnet Mask
4 Default Gateway
5 Name Server 1: Primary Domain Name System (DNS) Server
6 Name Server 2: Secondary Domain Name System (DNS) Server
7 Domain Name
8 Spanning Tree Mode

 

1

2

3 4

Item Description
1 Switch Details Drop-Down Menu

2 A maximum of 16 VLANs will be displayed. If the number of VLANs configuration on the switch 
exceeds 16 then the faceplate will display a message “There are more than 16 VLANs configured”.

3 VLAN Number. Note the switch is pre-configured with a default VLAN which has ID 1.
4 VLAN Name
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Port Tab

The Port Tab screens provide detailed information about selected Switch ports 
to help troubleshoot connections for a specific port.

There are two ways to navigate to these screens: Click on the Port button on the 
left, and then select the port from the drop-down on the right or Click on the 
desired port icon on the Home Tab.

The drop-down selector in the top left offers the following options:
• Status
• Statistics

 

1

2

3

4
5
6
7
8

9

Item Description
1 Switch Details Drop-Down Menu
2 Clock selector: Grandmaster/Local Clock
3 Time Sync: Enabled/Disabled

4
Identity: unique identifier for the grand master clock. The format depends on the network protocol. 
Ethernet encodes the MAC address into the identifier while DeviceNet and ControlNet encode the Vendor ID 
and serial number.

5 Class: measure of the quality of the grand master clock. Values are defined from 0 through 255 with zero 
(0) as the best clock.

6 Accuracy: Indicates the expected absolute accuracy of the grand master clock relative to CIP Sync Time 
Synchronization epoch (31 December, 1969 23:59:51.99918 UTC).

7 Variance: Displays the measure of inherent stability properties of the grandmaster clock. The value is 
represented in offset scaled log units. The lower the variance, the better the clock

8 Source: Time source of the clock. Atomic Clock/GPS/Terrestrial Radio/PTP/NTP/HAND Set/Other/Internal 
Oscillator

9 Priority 1 & 2: relative priority of the grandmaster clock to other clocks in the system. The value is between 
0 and 255. The highest priority is zero (0).
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• Media Counter
• Thresholds
• Time Sync

Port - Status

 

1

2
3
4

5
6
7
8

9

Item Description
1 Port Details Drop-Down Menu

2 Link: Displays whether the link between the Switch Port and the attached device is Active or Inactive or 
Disabled or Fault/Alarm

3
Speed/Duplex: Displays operating speed and duplex type of port. Available duplex types are:
- Full
- Half

4

Auto-Negotiation: Displays current state of Auto-negotiation process. Available Auto-negotiation states 
are:
- In Progress
- Failed
- Duplex Fail
- Ok
- Forced

5

Smartport: Displays the Smartport role that will be applied to the connected port, these are preset 
recommended configurations for the switch ports. These configurations, referred to as port roles, 
optimize the switch connections and provide security, transmission quality, and reliability for traffic from 
the switch Ports. The port roles also help prevent port mis-configurations.
The available values for each port are:
- Automation Device - Port is configured to be connected to a single EtherNet/IP (Ethernet Industrial 
Protocol) device. This role can be used to manage industrial automation devices, such as logic controllers 
and I/O
- Desktop for Automation - Port is configured to be connected to desktop devices, such as desktop PCs, 
workstations, notebook PCs, and other client-based hosts
- Switch for Automation - Port is configured to be connected to other switches that support Spanning 
Tree, such as, Stratix® 8000, Stratix® 6000 release 3, or Cisco switches
- Router for Automation - Port is configured to be connected to Cisco routers or Layer 3 switches with 
routing service capabilities. Use this role if the port will connect to devices that connect to the WAN or the 
Internet
- Phone for Automation - Port is configured to be connected to Cisco IP phones. A desktop device, such as 
a PC, can be connected to the IP phone. Both the IP phone and the connected PC would have access to the 
network and the Internet through the switch port
- Wireless for Automation - Port is configured to be connected to Cisco Wireless Access Point
- Multiport Automation Device - Port is configured to be connected to multiport EtherNet/IP (Ethernet 
Industrial Protocol) devices
- Virtual Desktop for Automation - Port is configured to be connected to PCs running virtualization 
software. This can be used with devices running up to two MAC addresses
- None - Apply this role to ports if you do not want a specialized Smartport role on the port
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Port - Statistics

Port - Media Counter

The Media Counters page displays the number of errors and collisions on a 
selected port.

6

Mode: Displays Administrative Mode of selected port, available modes for each port are:
- Dynamic Auto 
- Access
- Trunk
- Dynamic Desirable
- Tunnel
- Routed Port

7 VLAN: Displays the VLAN ID for configured VLANs. The default VLAN ID, 1, cannot be edited or deleted
8 Utilization: Displays current port utilization
9 Drop-down selector for desired port number.

Item Description

 

1

2
3
4

5
6
7
8

9

Item Description
1 Port Details Drop-Down Menu

2
Statistics type
- Input Statistics: packets received/inbound packets
- Output Statistics: packaged transmitted/outbound packets

3 Octets: The number of octets that are received/transmitted by the port

4
Unicast: The total number of well-formed unicast packets received/transmitted by a port. It excludes 
packets received with errors, with multicast or broadcast destination addresses, undersize packets, 
discarded packets, or packets without a destination

5
Non-Unicast: The total number of well-formed multicast packets received/transmitted by a port. It 
excludes packets received with errors, with unicast or broadcast destination addresses, oversized or 
undersized packets, discarded packets, or packets without a destination

6 Discards: The number of inbound/outbound packets that have been discarded
7 Errors: The number of inbound/outbound packets that contain errors
8 Unknown Protocols: The number of inbound/outbound packets with unknown protocols
9 Drop-down selector for desired port number.
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Port - Thresholds

The Thresholds screen displays packets passing from an interface to the 
switching bus. The switch counts the number of packets of a specified type that 
is received within the 1-second time interval and compares the measurement 
with a predefined suppression-level threshold.

 

1

2
3
4

5
6
7

8

9
10
11

12
13
14

Item Description
1 Port Details Drop-Down Menu
2 Alignment Errors: The number of frames received that are not an integral number of octets in length

3 FCS (Frame Check Sequence) Errors: The number of frames received that do not pass the Frame, check 
Sequence test

4 Single Collisions: The number of single (multiple, late) frame collisions detected by the interface.
5 Multiple Collisions: The number of multiple collisions detected by the interface
6 SQE Test Errors: The number of times that the SQE TEST ERROR is generated
7 Deferred Transmissions: The count of transmissions that are deferred by busy network
8 Drop-down selector for desired port number.
9 Late Collisions: The number of late collisions detected by the interface
10 Excessive Collisions: The number of frames for which transmission fails due to excessive collisions
11 MAC TX Errors: The number of frames that failed to transmit due to an internal MAC sublayer transmit error

12 Carrier Sense Errors: The number of times the carrier sense condition was lost or never asserted when 
attempting to transmit a frame

13 Frame Too long: The number of frames received that exceed the maximum permitted frame size

14 MAC RX Errors: The number of frames that failed to be received due to an internal MAC sublayer receive 
error
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Port - Time Sync

The Time Sync screen displays port Precision Time Protocol (PTP) 
synchronization status (Enable/Disable) and current state of the Time 
Synchronization port on the device.

 

 

1

2
3

4
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Alarm Tab

The Alarm Tab screens provide details for global switch alarms and individual 
Port alarms Click on the tab with exclamation icon, then select Global or Port 
Screens using left drop-down selector.

There are multiple way to get to these screens:
• Click on the banner if alarm text appears or click on individual port.
• An Active Alarm is indicated by a yellow rectangle button.

Item Description
1 Port Details Drop-Down Menu
2 Port Time Sync Status: Enabled/Disabled

3

Port PTP State:
- Unknown
- Initializing: The switch port is waiting while a parent or grand master clock is selected
- Faulty: Either PTP is not operating properly on that switch port or nothing is connected to the port
- Forward: This switch passes PTP packets as normal multicast traffic. All switch ports are enabled by 
default
- Listening: The switch port is waiting while a parent or grand master clock is selected
- Pre-Master: The switch port is transitioning to change to Master state
- Master: The switch is acting as a parent clock to the devices connected to that switch port
- Passive: The switch has detected a redundant path to a parent or grand master clock. For example, two 
different switch ports claim the same parent or grand master clock. To prevent a loop in the network, one 
of the ports changes to Passive state
- Uncalibrated: The switch port cannot synchronize with the parent or grand master clock
- Slave: The switch port is connected to and synchronizing with the parent or grand master clock

4 Drop-down selector for desired port number.
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Clicking on the yellow button will launch the Alarm Details screen providing 
an alarm description and recommended actions, click on the X on the upper 
right corner to close the alarm details screen.

There are two type of alarms will be displayed on the alarm tab:
• Global Alarms
• Port Alarms

Global Alarms

Set the drop-down selector to Global Alarms to display global switch alarms.

Active alarms are shown with a yellow LED icon and a darker gray background. 
You can click on the active alarm to see more details.
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Port Alarms

Click on left drop-down menu and select Port Alarms option. This will allow 
you to view and use the right drop-down menu to navigate between specific 
port alarms.

Active alarms are shown with a yellow LED icon and a darker gray background. 
You can click on the active alarm to see more details.

1

2

3

4

5

6

7

8

Item Description
1 Drop-down selector Global Alarms/Port Alarms
2 SD Card: Indicates Alarms generated by a faulted SD card.

3
Power Supply: The switch monitors DC power supply levels. If the system is configured to operate in a 
dual power mode, an alarm is triggered if a power supply fails or is missing. The alarm is automatically 
cleared when the power supplies are present or working.

4 License File: An alarm is triggered when the license file is corrupt.

5 Primary Temperature: These alarms are triggered when the system temperature is higher or lower than 
the configured thresholds. By default, the primary temperature alarm is associated with the major relay.

6 Secondary Temperature: These alarms are triggered when the system temperature is higher or lower 
than the configured thresholds.

7 Major Output: User can configure the switch to trigger an external alarm device. The switch software is 
configured to detect faults that are used to energize the relay coil and change the state.

8 Input 1/2/3/4 Event: An alarm is triggered based on an external input 1/2/3 alarm. Input 3 and 4 visibility 
depends on switch type.
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1 2

3

Item Description
1 Drop-down selector - Global Alarms/Port Alarms
2 Drop-down selector - Port Selection
3 Ports with an active alarm display an alarm bell icon in the drop-down menu

1

2

3

4

5

6

8

9

7

10

11

12

13

Item Description
1 Drop-down selector - Global Alarms/Port Alarms

2 Unauthorized Device: Indicates that an unauthorized MAC ID has attempted to communicate on a specific 
port.

3 Link Fault: Connection Fault detected on a specific port, including disconnected cable.

4 Port Not Forwarding: The switch generates a port not-forwarding alarm when a port is not forwarding 
packets.

5 Port Not Operating: The switch generates a port not-operating alarm when a port fails during the startup 
self-test.

6 FCS Bit Error Rate: The switch generates an FCS bit error-rate alarm when the actual FCS bit error-rate is 
close to the configured rate.

7 Error Disable
8 Drop-down selector - Port Selection
9 SFP Disabled: Software placed the SFP interface in an error-disabled state.
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Banner

A banner will be displayed at the top of each screen to provide the following 
information of the device:

• Ready 
• Not Ready (device will show Not Ready and fault message)
• AOI Not Enabled

There are two types of banner available that provides the overall status of the 
switch.

• Abbreviated version of the banner: Only available on Home tab

• Full version of banner : Available on Switch, Port & Alarm tab

10 Native VLAN Mismatch: Connected switches the native VLAN numbers differ.
11 MAC Address Flap: Switch detected that a MAC address is being learned on alternating switch ports.
12 Port Security Violation: A security violation occurred on a selected port
13 Port Threshold Exceeded: Port traffic exceeded a preset threshold

Item Description
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The full banner will be visible when there is any alarm or fault present on 
switch or on any port, or when AOI is not enabled. 

When an alarm or fault is preset a reset button is visible on banner to reset 
alarms or faults.

When the device is healthy and no alarms are present then ready with green 
LED will be shown on banner.



Rockwell Automation Publication DEVICE-RM400B-EN-P - January 2024 95

Chapter 6          Stratix® Switch (raC_Dvc_Stratix)

Application Code Manager Network Device Library objects can be set-up and configured using Studio 
5000® Application Code Manager.

Refer to the section Using Application Code Manager for complete details.

Definition Objects: raC_Dvc_Stratix

This Asset-Control object contains the Add-On Instruction definition and 
required data types. It is used as a linked library to the device implement 
object. This gives users the flexibility to choose to instantiate only definition 
and create custom implement code. A user may also create their own 
implement library and link with this definition library object.

Implementation Objects: raC_LD_Dvc_Stratix

The Device Implementation Object is the rung that is instantiated when 
generating controller code using Application Code Manager. This 
implementation object includes a reference to the Asset-Control Add-On 
Instruction definition, along with any required controller tags, programs, 
modules, and HMI objects.

The Stratix® implementation has the following configuration parameters.

Parameter Name Default Value Instance Name Definition Description

RoutineName {ObjectName} {RoutineName} Routine

Enter Routine name.  Routine will be created and Object implement 
rung(s) inserted.  
A JSR will be inserted in MainRoutine.  
If routine name already exists, then object will be inserted into 
existing routine.  
By default, parameter is set to Object Name.

TagName {ObjectName} {TagName} Backing Tag
Enter the backing tag of the main AOI.
This will serve as the base tag name for other tags in this object that 
are derived from the base.

TagDescription {ObjectDescription} {TagDescription} Tag Description of the main AOI backing tag

ModuleName Mod_[ObjectName] [ModuleName] Enter the Module Name. This is the name for the module that 
appears in the Controller Organizer tree.

IncludeHW True
Allow ACM to create the Hardware Module. If the module already 
exists in the Controller Organizer, select False or existing module 
properties will be overwritten.

ModuleType Stratix® 2500

Select hardware module type:
Stratix® 2500
Stratix® 5400
Stratix® 5410
Stratix® 5700
Stratix® 5800

CatalogNo Select Stratix® hardware module type
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Linked Libraries

Configured HMI Content

Attachments

IPAddress 192.168.1.0 Enter a valid network address for the hardware module. It must be 
of form X.X.X.X

ParentModule Local Module

Select the Parent Module. This represents the name of the 
communications adapter this module will communicate through. If 
connecting to a non-library object module enter the name of the 
module only. If the module is connected directly to the controller 
Ethernet port, enter “Local”. Note: entering non-library object 
modules will result in the parameter displaying a red ‘X’. This will still 
generate properly as long as the entered name exists in the project.

NavigationButton Icon Select navigation button type. Icon/Text. See FactoryTalk® View ME/
SE Graphic Symbols for more information.

Parameter Name Default Value Instance Name Definition Description

Note that if the tag names are manually entered or not linked to ParentModule tags a 
red ‘X’ will be shown beside the parameter. This is acceptable and the program can 
still be generated.

Link Name Catalog Number Revision  Solution   Category

raC_Dvc_Stratix raC_Dvc_Stratix 12.2 (RA-LIB) Device Network

HMI Content Instance Name  Description

Launch Button {ObjectName}_GO_LaunchFP_Text Global Object launch button using basic text label.

Launch Button {ObjectName}_GO_LaunchFP_Icon Global Object launch button using schematic style device icon.

 Name Description File Name Extraction Path

V12_raC_Dvc_Globall Graphic Symbols ME (raC-12-ME) Graphic Symbols - Network Device.ggfx {ProjectName}\Visualization\FTViewME\GlobalObjects

V12_raC_Dvc_Stratix® Switch Faceplate ME (raC-12_xx-ME) raC_Dvc_S2500-Faceplate.gfx {ProjectName}\Visualization\FTViewME\Displays

V12_raC_Dvc_Stratix® Switch Faceplate ME (raC-12_xx-ME) raC_Dvc_S5400-Faceplate.gfx {ProjectName}\Visualization\FTViewME\Displays

V12_raC_Dvc_Stratix® Switch Faceplate ME (raC-12_xx-ME) raC_Dvc_S5410-Faceplate.gfx {ProjectName}\Visualization\FTViewME\Displays

V12_raC_Dvc_Stratix® Switch Faceplate ME (raC-12_xx-ME) raC_Dvc_S5700-Faceplate.gfx {ProjectName}\Visualization\FTViewME\Displays

V12_raC_Dvc_Stratix® Switch Faceplate ME (raC-12_xx-ME) raC_Dvc_S5800-Faceplate.gfx {ProjectName}\Visualization\FTViewME\Displays

V12_raC_Dvc_Globall Graphic Symbols SE (raC-12-ME) Graphic Symbols - Network Device.ggfx {ProjectName}\Visualization\FTViewSE\GlobalObjects

V12_raC_Dvc_Stratix® Switch Faceplate SE (raC-12_xx-SE) raC_Dvc_S2500-Faceplate.gfx {ProjectName}\Visualization\FTViewSE\Displays
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V12_raC_Dvc_Stratix® Switch Faceplate SE (raC-12_xx-SE) raC_Dvc_S5400-Faceplate.gfx {ProjectName}\Visualization\FTViewSE\Displays

V12_raC_Dvc_Stratix® Switch Faceplate SE (raC-12_xx-SE) raC_Dvc_S5410-Faceplate.gfx {ProjectName}\Visualization\FTViewSE\Displays

V12_raC_Dvc_Stratix® Switch Faceplate SE (raC-12_xx-SE) raC_Dvc_S5700-Faceplate.gfx {ProjectName}\Visualization\FTViewSE\Displays

V12_raC_Dvc_Stratix® Switch Faceplate SE (raC-12_xx-SE) raC_Dvc_S5800-Faceplate.gfx {ProjectName}\Visualization\FTViewSE\Displays

V12_raC_Dvc_SDtratix View Designer (raC-12_xx-VD) raC_Dvc_Stratix.vpd {ProjectName}\Visualization\ViewDesigner

V12_RM_raC_Dvc_Network Reference Manual DEVICE-RM400B-EN-P.pdf {ProjectName}\Documentation

V12_Network_Images HMI Image Set HMI FactoryTalk® View Images - png.zip {ProjectName}\Visualization\Images

V12_raC_Dvc_Network_Global Toolbox ME (raC-12-ME) Toolbox - Network Device.ggfx {ProjectName}\Visualization\FTViewME\GlobalObjects

V12_raC_Dvc_Network_Global Toolbox SE (raC-12-SE) Toolbox - Network Device.ggfx {ProjectName}\Visualization\FTViewSE\GlobalObjects
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Chapter 7

Single Device Level Ring (raC_Opr_NetDLR1, 
raC_Opr_NetDLR1_Lite)

Overview The Single Device Level Ring device objects (raC_Opr_NetDLR1 and 
raC_Opr_NetDLR1_Lite) include HMI faceplates for single Device Level Ring 
(DLR) networks which displays network information including:

• Automatically generated network topology
• Detailed ring network data and statistics
• Network fault monitoring including graphical identification and 

location of faulted network links
• Ring supervisor, ring participant, and redundant gateway information

The standard object (raC_Opr_NetDLR1) can be used for DLR networks 
containing up to 56 nodes. The smaller Lite version of the instruction 
(raC_Opr_NetDLR1_Lite) can be used with smaller networks up to 12 nodes.

Functional Description The Single Device Level Ring pre-configured Device Objects:
• Collects and processes data from the Active Ring Supervisor and 

participant node devices and delivers data to the status and diagnostic 
faceplates.

• Provides enhanced DLR network and node status and diagnostic 
information simplifying network maintenance and reducing network 
downtime.

All these features provide quick feedback, shorten recovery time, and simplify 
implementation.

Required Files Device Objects include Add-On Instructions (AOIs) and HMI faceplates. The 
revision number (e.g. 1.01) used in filenames can change as new revisions are 
created.

Controller Files

Add-On Instructions are reusable code objects that contain encapsulated logic 
that can streamline implementing your system. This lets you create your own 
instruction set for programming logic as a supplement to the instruction set 
provided natively in the ControlLogix® firmware. An Add-On Instruction is 

In the Library there is a folder named Videos which contains many How-To and 
Operational Overview Videos which walk step-by-step through each process. You 
can refer to the following videos for this section:
“Operational Overview of DLR Object Faceplates”
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defined once in each controller project, and can be instantiated multiple times 
in your application code as needed.

The Add-On Instruction must be imported into the controller project to be 
used in the controller configuration. These can be imported as Add-On 
Instruction files, or as part of the Rung Import or Import Library Objects 
wizard. 

All Add-On Instruction and Rung Import files can be found in the /Studio 5000 
Logix Designer Files - L5X/ folder in the library. 

FactoryTalk® View HMI Files

FactoryTalk® View ME and FactoryTalk® View SE applications require 
importing the desired device faceplates in addition to all Global Object (ggfx) 
files and all images located in the /HMI FactoryTalk® View Images - png/ folder of 
the library. FactoryTalk® View ME files are stored in the /HMI - FactoryTalk® 
View ME/ library folder and FactoryTalk® View SE files are stored in the /HMI - 
FactoryTalk® View SE/ library folder.

Note that the Add-On Instruction raC_Opr_NetDLR1 can be used with either 
the 24 Node or 56 Node displays depending on the size of the network. The 
HMI faceplate will automatically display the correct layout for connected 
network.

Studio 5000 View Designer® HMI Files

All Studio 5000 View Designer® Files can be found in the /HMI - ViewDesigner - 
vpd/ folder of the library.

Object Compatible
Network Configuration Add-On Instruction Rung Import

raC_Opr_NetDLR1 Single ring up to 56 nodes raC_Opr_NetDLR1_12.02_AOI.L5X raC_Opr_NetDLR1_12.02_RUNG.L5X
raC_Opr_NetDLR1_Lite Single ring up to 12 nodes raC_Opr_NetDLR1_Lite_12.02_AOI.L5X raC_Opr_NetDLR1_Lite_12.02_RUNG.L5X

Device/Item
Compatible
Network 
Configuration

Type FactoryTalk® View ME
Faceplate

FactoryTalk® View SE
Faceplate

raC_Opr_NetDLR1_Lite Single ring up to 
12 nodes Display (raC-12_02-ME) raC_Opr_NetDLR1_12Node-Faceplate.gfx (raC-12_02-SE) raC_Opr_NetDLR1_12Node-Faceplate.gfx

raC_Opr_NetDLR1

Single ring up to 
24 nodes Display (raC-12_02-ME) raC_Opr_NetDLR1_24Node-Faceplate.gfx (raC-12_02-SE) raC_Opr_NetDLR1_24Node-Faceplate.gfx

Single ring up to 
56 nodes Display (raC-12_02-ME) raC_Opr_NetDLR1_56Node-Faceplate.gfx (raC-12_02-SE) raC_Opr_NetDLR1_56Node-Faceplate.gfx

Graphic Symbols All DLR Global Object (raC-12-ME) Graphic Symbols - Network Device (raC-12-SE) Graphic Symbols - Network Device
Toolbox All DLR Global Object (raC-12-ME) Toolbox -Network Device.ggfx (raC-12-SE) Toolbox -Network Device.ggfx
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Studio 5000® Application Code Manager Files

Studio 5000® Application Code Manager (ACM) can be optionally used if it is 
installed. All devices can be easily registered in the ACM repositories by 
running the setup.cmd file located in the root folder of the library.

Individual HSL4 files are provided as an alternative to running the setup.cmd 
to allow users to manually register specific implementation objects. Each 
object has two files - an Asset Control file and a Device file. The Asset Control 
files include attachments of all required files for that object. The Device files 
are used to actually add that device into a Studio 5000® project and these 
reference the Asset Control files. 

All Studio 5000® Application Code Manager files can be found in the /
ApplicationCodeManagerLibraries/ folder of the library. The files included are as 
follows:

Operations The Network Device objects provide only physical operation mode. There is no 
virtual device mode offered.

Execution

The following table explains the handling of instruction execution conditions.

Device/Item Studio 5000 View Designer® Faceplate
All Device Level Ring Objects (raC-12_02-VD) raC_Opr_NetDLR.vpd

Implementation 
Object

Compatible
Network 
Configuration

Asset Control File (.HSL4) Device File (.HSL4)

DLR1 Lite Single ring up to 
12 nodes (RA-LIB)_Device_Asset-Control_Network_raC_Opr_NetDLR1_Lite_(12.3) (RA-LIB)_Device_Device_Network_raC_LD_Opr_NetDLR1_Lite_(12.3)

DLR1 Single ring up to 
56 nodes (RA-LIB)_Device_Asset-Control_Network_raC_Opr_NetDLR1_(12.3) (RA-LIB)_Device_Device_Network_raC_LD_Opr_NetDLR1_(12.3)

Condition Description

EnableIn False (false rung)
Processing for EnableIn False (false rung) is handled the same as if the device were 
taken out of service by Command. The device outputs are de-energized and the device 
is shown as Program Out of Service on the HMI. All alarms are cleared.

Powerup (prescan, first 
scan)

On prescan, any commands that are received before first scan are discarded. The 
device is de-energized. On first scan, the device is treated as if it were returning from 
Hand command source: the instruction state is set based on the position feedback that 
is received from the device. If the feedback is valid for one position, the device is set to 
that position. If the device does not have position feedback or the position feedback is 
invalid, the device is set to the ‘unknown/powerup’ state.
The command source is set to its default, either Operator or Program (unlocked).

Postscan No SFC Postscan logic is provided.
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Add-On Instruction I/O Data InOut Data

Input Data

Output Data

Data Types A number of User-Defined Datatypes (UDT) are used in the Network Device 
Library. A full list of the UDTs used with the raC_Opr_NetDLR1 and 
raC_Opr_NetDLR1_Lite objects follows:

InOut Function / Description  DataType

Ref_Path_to_DLR CIP path to DLR network STRING

Ref_Msg_Get_All Message used to read complete CIP 
objects. MESSAGE

Ref_Msg_Get_Single Message used to read vendor specific 
attributes. MESSAGE

Ref_Msg_Get_Member Message used to read member attributes MESSAGE

Ref_Msg_Rst_SignOn Message used to sign on to switch MESSAGE

Ref_Storage Stores CIP message data SINT[520]

Input Function/Description DataType

EnableIn Enable Input - System Defined Parameter  BOOL 

Inp_Enable Enable AOI functions. 1 = enabled. BOOL

Inp_RefreshInhibit Inhibit data refresh BOOL

Output Function/Descritpion DataType

EnableOut Enable Output - System Defined Parameter BOOL

Sts_EN AOI Enabled Status; 1 = enabled. BOOL

Sts_ER Message error bit; 1= Error BOOL

Sts_Connected Device is connected to the Programmable 
Controller BOOL

Sts_Available Device is available for interaction with user code BOOL

Sts_Faulted Device faulted status: 1 = an active fault exists BOOL

Ref_HMI Alias tag for HMI_Parameters.Tab_Active DINT
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Add-On Instructions A number of embedded Add-On Instructions (AOI) are used within the 
raC_Opr_NetDLR1 and raC_Opr_NetDLR1_Lite instructions. These are used to 
convert between datatypes and generate values which can be read from the 
HMI faceplate. The following AOIs are included:

User Defined Datatype Description
raC_UDT_DLRActive_Node DLR Active Node Address
raC_UDT_DLRCapture_Error DLR Error Information
raC_UDT_DLRDropdowns DLR Drop-down menu
raC_UDT_DLRFaults DLR HMI Faceplate Information - Faults
raC_UDT_DLRHMI/raC_UDT_DLRLiteHMI DLR HMI Faceplate Information
raC_UDT_DLRHome/raC_UDT_DLRLiteHome DLR HMI Faceplate Information - Home Tab
raC_UDT_DLRLast_Node DLR Last Node Information
raC_UDT_DLRLocalData/raC_UDT_DLRLiteLocalData DLR HMI local data
raC_UDT_DLRMAC DLR Mac Address
raC_UDT_DLRNode/raC_UDT_DLRLiteNode DLR HMI Faceplate Information - Node
raC_UDT_DLRNode_Info/raC_UDT_DLRLiteNode_Info DLR Node Information
raC_UDT_DLRRedGateway DLR Redundant Gateway information
raC_UDT_DLRRing DLR HMI Faceplate Information - Ring
raC_UDT_DLRTakeover_Order DLR Takeover Precedence order
STR0002 String
STR0016 String
STR0032 String

User Defined Datatype Revision Description
raC_Tec_DecToHex 12.02 Converts decimal number to hexadecimal String
raC_Tec_DLRClearNodeInfo/
raC_Tec_DLRClearNodeInfo_Lite 12.02 Clears node information

raC_Tec_DLRIcon 12.02 Determines device icon used in DLR network 
schematic

raC_Tec_IPMACtoString_NET 12.02 Converts numerical IP/MAC address into user-
readable string

raC_Tec_MACCompare 12.02 Compares two MAC addresses

raC_Tec_PathSplit 12.02 Strips and separates the last IP address from 
the path

raC_Tec_PathToHex 12.02
Converts a comma separated string (as typed in 
“Path” of MSG) to Hex Path string as used in 
MSG.Path element



104 Rockwell Automation Publication DEVICE-RM400B-EN-P - January 2024

Chapter 7          Single Device Level Ring (raC_Opr_NetDLR1, raC_Opr_NetDLR1_Lite)

Programming Example Fully configured device on a rung is provided below for reference. 

Note that this programming example is the same code that is imported when 
either importing the supplied rung .L5X files or when using Application Code 
Manager or the Studio 5000® Import Library Objects wizard plug-in.

The following example uses the Single Device Level Ring device object named 
Dvc_DLR1. The Ref_Path_to_DLR points to the STRING variable called 
Dvc_DLR1_Path which is set to ‘1,5,2,192.168.50.1’. See Message Paths for more 
information and examples on assigning this string. This path is defined as 
follows:

Graphic Symbols Graphic Symbols are used as launch buttons within HMI applications to open 
up faceplate displays. See Basic Launch Button Attributes section for details on 
configuration and indicators.

FactoryTalk® View ME/SE Graphic Symbols

Item Description
1 This controller 1756-L8x
5 Slot 5 - 1756-EN2TR Ethernet module connected to DLR network
2 Ethernet Network
192.168.50.1 IP Address of 1756-EN2TR ethernet module 

Graphic Symbol Name Graphic Symbol Description Global Object Parameter Values

GO_LaunchFP

Faceplate navigation button with string tag label.
This launch button graphic object allows the user 
to navigate to the device object faceplate.
The text on the button face is set to the parameter 
#104.

#102: AOI Backing Tag Instance (e.g. 
{::[PAC]._InstanceName})
#104: Navigation Button Label
#120: Display’s left position (e.g. 100) (optional)
#121: Display’s top position (e.g. 100) (optional)
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Studio 5000 View Designer® Graphic Symbols

Text displayed in the launch buttons can be modified from the Properties tab 
using the General > Text parameter.

Faceplates There are basic faceplate attributes that are common across all instructions. 
See Basic Faceplate Attributes on page 22.

In this document, the faceplate pictures (or snapshots) are of 24-node 
faceplate, although the 56-node screens and 12-node screens operate 
identically with only Home Tab difference displaying up to 56 nodes and 12-
nodes respectively instead of 24. Also the Redundant Gateway option is not 
applicable for 12-node DLR Network irrespective of 24-node and 56-node 
Network. 

Faceplate Navigation

Graphic Symbol Name Graphic Symbol Description Property Configuration

btn_nav_NetDLR1_12Node_FP
Navigate to 12 Node 
Single DLR Faceplate 
Pop-Up Screen

btn_nav_NetDLR1_24Node_FP
Navigate to 24 Node 
Single DLR Faceplate 
Pop-Up Screen

btn_nav_NetDLR1_56Node_FP
Navigate to 56 Node 
Single DLR Faceplate 
Pop-Up Screen
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• The Home tab provides connected ring network layout and node icons 
with device information (Catalog Number, IP Address).

• The Ring tab provides the Active Ring Supervisor details, Active 
Redundant Gateway details.

• The 
• Node tab provides details for all connected nodes.
• The Fault tab provides network fault information and location.

Home

The Home screen is visible when the Home tab button is selected in the tab 
control object on the left side of the screen. The Home tab screen displays an 
auto-generated network layout. This example is displaying 24-node network. 
The number and sequence of nodes are based on the information provided by 
the Active Ring Supervisor.
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The Active Ring Supervisor is always located on the upper left position of the 
screen and it is identified by the star icon at the upper right corner of the node.

If the Backup Supervisor is configured, then it is identified by numerical icons 
at the upper right corner of the nodes. The numerical order indicates the order 
taken over by the supervisor, if the initial Active Ring Supervisor and 
subsequent Backup Supervisor cannot perform functions any longer.

In addition, each node will display its catalog number and IP address as 
reported by the device.

Detailed node information can be accessed by pressing the individual device 
Icons.

Devices without IP addresses can participate in the DLR and will be identified 
with a question mark. Device catalog number will be shown only if node 
responds to Identity request by the Add-On Instruction (AOI), otherwise a 
question mark icon will be shown. 
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If a network connection fault is detected, a Link Fault indicator represented by 
the round yellow circle with an exclamation mark will appear on the network 
layout at the point or points of failure. In addition, a yellow border will appear 
on the network fault tab navigation button. Once the failed connection is 
restored, the Link Fault indicator will disappear.

Note: Refer the Fault tab section for more information on the faults detected

If a node is no longer responding, for example, if node power turned off, then 
missing node will be shown with “X” sign over the device icon.

Once the node functionality and connections are restored, the node and the 
associated link appearance will be restored to the normal state.

Ring Tab

The Ring Tab provides more information about the Device Level Ring network. 
The drop-down menu next to the Ring selector allows users to select the 
detailed Ring Information, Active Supervisor Identity, Active Supervisor 
Capabilities or Redundant Gateway information.
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Ring Information

The Ring information provides basic network configuration, status and 
diagnostic information to assist in troubleshooting potential network 
problems.

Network Topology “Ring” state indicates that at least one node has the Active 
Ring Supervisor function enabled. The faceplate will be suspended if network 
is transitioned from the ring to the linear topology. 

Network “Normal” state indicates that the ring is functioning correctly and no 
link faults are present. Otherwise, network status will indicate the various type 
of faults as reported by the Active Ring Supervisor.

In addition, this display shows currently active DLR configuration parameters 
that can be used for DLR network configuration, maintenance and 
troubleshooting.

Please refer to the DLR user guides for more information.
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https://literature.rockwellautomation.com/idc/groups/literature/documents/
at/enet-at007_-en-p.pdf

https://literature.rockwellautomation.com/idc/groups/literature/documents/
td/enet-td015_-en-p.pdf

Active Supervisor Identity

The Active Ring Supervisor is automatically determined based on the 
precedence value and MAC address. The Active Supervisor identity 
information helps the user to identify the device that is currently acting as the 
Active Ring Supervisor. This information includes the MAC address, IP 
address, Catalog Number, Vendor, Device Type, Product Code and Serial 
Number. Firmware Revision helps with troubleshooting to determine if the 
device firmware is current.

This information is updated in real time and will reflect any changes in the 
Active Ring Supervisor.

Active Supervisor Capabilities

The Active Supervisor capability information provides the configuration and 
device capabilities of the Active Ring Supervisor which helps with device 
configuration and troubleshooting. See Node Capabilities for details.

https://literature.rockwellautomation.com/idc/groups/literature/documents/at/enet-at007_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/td/enet-td015_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/td/enet-td015_-en-p.pdf
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Redundant Gateway

If Redundant Gateway functionality is enabled on the DLR network, then this 
screen will display information about the device that acts as an Active 
Redundant Gateway, including IP address, MAC address and Gateway 
Precedence value. 

Redundant Gateway option is not applicable for 12-node DLR Network.

        

Node Tab

The DLR faceplate also allows user to display information about all DLR 
participant nodes. For specific node information, select the Node Tab 
navigation button.



112 Rockwell Automation Publication DEVICE-RM400B-EN-P - January 2024

Chapter 7          Single Device Level Ring (raC_Opr_NetDLR1, raC_Opr_NetDLR1_Lite)

The node selection dropdown at the top right side of the node tab display 
allows user to access a specific node based on the IP or MAC address.

Node Information

The Node Information display helps users to associate the specific node by one 
or more of its identity parameters:

Catalog Number, MAC address, IP address, Vendor, Device Type, Product 
Code, Serial number. It also allows to verify if firmware revision meets the user 
requirements.

Node Mode

The Node Mode information provides the role of a specific node on the 
network, either normal node, Active Supervisor, or Backup Supervisor. 
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Please note that Supervisor Precedence is not the same as the Takeover Order 
shown on the Home screen. The Takeover order is calculated by the Add-On 
Instruction and is based on the precedence value and individual MAC 
addresses.

Node Capabilities

The Node Capabilities provide the information that potentially helps with 
node configuration and troubleshooting.

The first two fields identify if the node’s DLR implementation is done in 
software (Announce-Based) or in Hardware (Beacon Based). 

Supervisor Capability indicates that a specific device can be configured as a 
supervisor.
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Some Supervisor capable devices can act as Redundant Gateway allowing 
multiple uplink connections to the distribution layer switches.

The Flush Table capability is required for all nodes that are present on the DLR 
network where a Redundant Gateway is enabled.

Redundant Gateway

The Redundant Gateway Display will provide detailed node configuration 
parameters, if the node is configured for Redundant Gateway. It will also 
indicate the Redundant Gateway status for selected node.

This information allows users to troubleshoot an issue related to the 
Redundant Gateway connections and loss of data.

Redundant Gateway option is not applicable for 12-node DLR Network.

Fault Tab

The Network Fault Tab provides details about network health. When a network 
fault occurs, it will indicate the fault type, fault location. Any fault clear/reset 
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operations should be performed via advanced user tools like Device Manager 
or Studio 5000 Logix Designer® Add-On Profile.

Network Fault

A fully functional DLR network should remain in Normal state. 

When a network fault occurs, the faceplate will indicate one of the following 
faults:

• Ring Fault
• Unexpected Loop Detected
• Partial Network Fault
• Rapid Fault/Restore Cycle Fault

Ring Fault: The most common fault, the Ring Fault – usually occurs when one 
or more link is broken, or a node is taken off the network.
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Unexpected Loop Detected: this fault occurs when the network ring was closed 
without defining at least one node as the Active Ring Supervisor – in Linear 
topology.

Partial Network Fault: occurs when the Active Ring Supervisor detects 
network fault in one direction only.
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Rapid Fault/Restore Cycle fault: Occurs when there are more than 5 
consecutive fault/recovery cycles detected in less than 30 seconds. This usually 
happens during network commissioning and indicates a severe hardware or 
cabling issue, or misconfiguration that requires immediate attention. When 
this fault occurs, it is required to restore normal operations after the fault 
cause was determined and corrected. Then Rapid Fault/Restore reset should be 
performed via advanced user tools like Device Manager or Studio 5000 Logix 
Designer® Add-On profile.

Ring Fault Count indicates number of ring faults since the Active Ring 
Supervisor’s power-up or last fault reset. 

Please note that the counter is just a status indicator and does not affect DLR 
or faceplate operations. 
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Ring Fault Reset should be performed via advanced user tools like Device 
Manager or Studio 5000 Logix Designer® Add-On Profile.

Fault Location

The fault location information provides a potential breaking point as reported 
to the faceplate by the Active Ring Supervisor.

Warning Information

The faceplate also provides a series of warnings, here are few examples:

Faceplate Displays rely on the information provided by the Add-On 
Instruction. 

If the Add-On Instruction operation is disabled by the user, then “AOI Not 
Enabled” warning message is shown and all faceplate operations will be 
suspended.
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If the detected number of nodes on the connected network exceeds 24 then the 
below warning will display and all faceplate operations will be suspended.

Likewise, if the number of nodes on a 56-node faceplate exceeds 56, a similar 
warning will replace the network layout and all faceplate operations will be 
suspended.

Similarly, if the number of nodes on 12-node faceplate exceeds 12, a warning 
will replace the network layout and all faceplate operations will be suspended.

The following message indicates that corresponding Logix Add-On Instruction 
(AOI) message to the DLR Supervisor failed. The incorrect or invalid path 
defined in the Add-On Instruction parameters is likely the cause of this error. 
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The following message will be displayed if AOI is pointing to a network that is 
not a DLR topology.

The initial scan of the network must be performed in “Normal” state where 
DLR is functioning without a fault or cable break. Otherwise, the following 
message will be displayed. Once DLR is restored to the Normal state, the 
faceplate will automatically build the network participant list and display 
current network topology.
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Application Code Manager Network Device Library objects can be set-up and configured using Studio 
5000® Application Code Manager.

Refer to the section Using Application Code Manager for complete details.

Definition Objects: raC_Opr_NetDLR1

This Asset-Control object contains the Add-On Instruction definition and 
required data types. It is used as a linked library to the device implement 
object. This gives users the flexibility to choose to instantiate only definition 
and create custom implement code. A user may also create their own 
implement library and link with this definition library object.

Implementation Objects: raC_LD_Opr_NetDLR1

The Device Implementation Object is the rung that is instantiated when 
generating controller code using Application Code Manager. This 
implementation object includes a reference to the Asset-Control Add-On 
Instruction definition, along with any required controller tags, programs, 
modules, and HMI objects.

The DLR1 implementation has the following configuration parameters.

Parameter Name Default Value Instance Name Definition Description

RoutineName {ObjectName} {RoutineName} Routine

Enter Routine name.  Routine will be created and Object implement 
rung(s) inserted.  
A JSR will be inserted in MainRoutine.  
If routine name already exists, then object will be inserted into 
existing routine.  
By default, parameter is set to Object Name.
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Linked Libraries

Configured HMI Content

Attachments

TagName {ObjectName} {TagName} Backing Tag
Enter the backing tag of the main AOI.
This will serve as the base tag name for other tags in this object that 
are derived from the base.

TagDescription {ObjectDescription} {TagDescription} Tag Description of the main AOI backing tag

Ref_Paths Enter a valid AOI Path. See Message Paths for more information.

Nodes 24 Nodes DLR1 Only; Not applicable to DLR1_Lite. Select 56 nodes if there are 
more than 24 nodes in DLR network.

Parameter Name Default Value Instance Name Definition Description

Link Name Catalog Number Revision  Solution   Category

raC_Opr_NetDLR1 raC_Opr_NetDLR1 12.2 (RA-LIB) Device Network

raC_Opr_NetDLR1_Lite raC_Opr_NetDLR1_Lite 12.2 (RA-LIB) Device Network

HMI Content Instance Name  Description

Launch Button {ObjectName}_GO_Launch_12Node_FP Global Object launch button to 12Node Faceplate using basic text 
label.

Launch Button {ObjectName}_GO_Launch_24Node_FP Global Object launch button to 24 Node Faceplate using basic text 
label.

Launch Button {ObjectName}_GO_Launch_56Node_FP Global Object launch button to 56 Node Faceplate using basic text 
label.

 Name Description File Name Extraction Path

V12_raC_Dvc_Globall Graphic Symbols ME (raC-12-ME) Graphic Symbols - Network Device.ggfx {ProjectName}\Visualization\FTViewME\GlobalObject

V12_raC_Dvc_DLR1_12Node Faceplate ME (raC-12_xx-ME) raC_Opr_NetDLR1_12Node-Faceplate.gfx {ProjectName}\Visualization\FTViewME\Displays

V12_raC_Dvc_DLR1_24Node Faceplate ME (raC-12_xx-ME) raC_Opr_NetDLR1_24Node-Faceplate.gfx {ProjectName}\Visualization\FTViewME\Displays

V12_raC_Dvc_DLR1_56Node Faceplate ME (raC-12_xx-ME) raC_Opr_NetDLR1_56Node-Faceplate.gfx {ProjectName}\Visualization\FTViewME\Displays

V12_raC_Dvc_Globall Graphic Symbols SE (raC-12-ME) Graphic Symbols - Network Device.ggfx {ProjectName}\Visualization\FTViewSE\GlobalObject

V12_raC_Dvc_DLR1_12Node Faceplate SE (raC-12_xx-SE) raC_Opr_NetDLR1_12Node-Faceplate.gfx {ProjectName}\Visualization\FTViewSE\Displays

V12_raC_Dvc_DLR1_24Node Faceplate SE (raC-12_xx-SE) raC_Opr_NetDLR1_24Node-Faceplate.gfx {ProjectName}\Visualization\FTViewSE\Displays

V12_raC_Dvc_DLR1_56Node Faceplate SE (raC-12_xx-SE) raC_Opr_NetDLR1_56Node-Faceplate.gfx {ProjectName}\Visualization\FTViewSE\Displays
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V12_raC_Opr_NetDLR View Designer (raC-12_xx-VD) raC_Opr_NetDLR.vpd {ProjectName}\Visualization\ViewDesigner

V12_RM_raC_Dvc_Network Reference Manual DEVICE-RM400B-EN-P.pdf {ProjectName}\Documentation

V12_Network_Images HMI Image Set HMI FactoryTalk® View Images - png.zip {ProjectName}\Visualization\Images

V12_raC_Dvc_Network_Global Toolbox ME (raC-12-ME) Toolbox - Network Device.ggfx {ProjectName}\Visualization\FTViewME\GlobalObjects

V12_raC_Dvc_Network_Global Toolbox SE (raC-12-SE) Toolbox - Network Device.ggfx {ProjectName}\Visualization\FTViewSE\GlobalObjects
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3-Ring Device Level Ring (raC_Opr_NetDLR3, 
raC_Opr_NetDLR3_Lite)

Overview The 3-Ring Device Level Ring device objects (raC_Opr_NetDLR3) include HMI 
faceplates for 3-Ring Device Level Ring (DLR) networks and Ring of Switch 
networks which displays network information including:

• Automatically generated network topology
• Detailed ring network data and statistics
• Network fault monitoring including graphical identification and 

location of faulted network links for up to three DLR networks
• Ring supervisor, ring participant, and redundant gateway information

The object (raC_Opr_NetDLR3) can be used for DLR networks containing up to 
56 nodes or a a ring of switches.

Functional Description The 3-Ring Device Level Ring pre-configured Device Objects:
• Collects and processes data from the Active Ring Supervisor and 

participant node devices and delivers data to the status and diagnostic 
faceplates.

• Provides enhanced DLR network and node status and diagnostic 
information simplifying network maintenance and reducing network 
downtime.

All these features provide quick feedback, shorten recovery time, and simplify 
implementation.

The following diagram shows an example of the type of network that can be 
supported by this object.

In the Library there is a folder named Videos which contains many How-To and 
Operational Overview Videos which walk step-by-step through each process. You 
can refer to the following videos for this section:
“Operational Overview of DLR Object Faceplates”
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Required Files Device Objects include Add-On Instructions (AOIs) and HMI faceplates. The 
revision number (e.g. 1.01) used in filenames can change as new revisions are 
created.

Controller Files

Add-On Instructions are reusable code objects that contain encapsulated logic 
that can streamline implementing your system. This lets you create your own 
instruction set for programming logic as a supplement to the instruction set 
provided natively in the ControlLogix® firmware. An Add-On Instruction is 
defined once in each controller project, and can be instantiated multiple times 
in your application code as needed.

The Add-On Instruction must be imported into the controller project to be 
used in the controller configuration. These can be imported as Add-On 
Instruction files, or as part of the Rung Import or Import Library Objects 
wizard. 

All Add-On Instruction and Rung Import files can be found in the /Studio 5000 
Logix Designer Files - L5X/ folder in the library. 

A

B

Node

Node Node

Node Node

Node

C D E F G

A: Switch 1; 192.168.1.5
B: Switch 2; 192.168.2.5
C: 1756‐EN2T; 192.168.1.10
D: 1756‐EN2T; 192.168.2.10
E: 1756‐EN2TR; 192.168.10.5
F: 1756‐EN2TR; 192.168.20.5
G: 1756‐EN2TR; 192.168.30.5

CIP Switch Management
Ring 1
Ring 2
Ring 3
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FactoryTalk® View HMI Files

FactoryTalk® View ME and FactoryTalk® View SE applications require 
importing the desired device faceplates in addition to all Global Object (ggfx) 
files and all images located in the /HMI FactoryTalk® View Images - png/ folder of 
the library. FactoryTalk® View ME files are stored in the /HMI - FactoryTalk® 
View ME/ library folder and FactoryTalk® View SE files are stored in the /HMI - 
FactoryTalk® View SE/ library folder.

Note that the Add-On Instruction raC_Opr_NetDLR3 can be used with either 
the 24 Node or 56 Node displays depending on the size of the network. The 
HMI faceplate will automatically display the correct layout for connected 
network.

Studio 5000 View Designer® HMI Files

All Studio 5000 View Designer® Files can be found in the /HMI - ViewDesigner - 
vpd/ folder of the library.

Studio 5000® Application Code Manager Files

Studio 5000® Application Code Manager (ACM) can be optionally used if it is 
installed. All devices can be easily registered in the ACM repositories by 
running the setup.cmd file located in the root folder of the library.

Individual HSL4 files are provided as an alternative to running the setup.cmd 
to allow users to manually register specific implementation objects. Each 
object has two files - an Asset Control file and a Device file. The Asset Control 

Object Compatible
Network Configuration Add-On Instruction Rung Import

raC_Opr_NetDLR3_RingOfSwitches Up to 3 Device Level Rings each with 
up to 56 nodes; Ring of Switches raC_Opr_NetDLR3_12.03_AOI.L5X raC_Opr_NetDLR3_12.03_RUNG.L5X

Device/Item
Compatible
Network 
Configuration

Type FactoryTalk® View ME
Faceplate

FactoryTalk® View SE
Faceplate

raC_Opr_NetDLR3

Up to 3 Device 
Level Rings each 
with up to 56 
nodes; Ring of 
Switches

Display (raC-12_02-ME) raC_Opr_NetDLR3_56Node-Faceplate.gfx (raC-12_02-SE) raC_Opr_NetDLR3_56Node-Faceplate.gfx

Graphic Symbols All DLR Global Object (raC-12-ME) Graphic Symbols - Network Device (raC-12-SE) Graphic Symbols - Network Device
Toolbox All DLR Global Object (raC-12-ME) Toolbox -Network Device.ggfx (raC-12-SE) Toolbox -Network Device.ggfx

Device/Item Studio 5000 View Designer® Faceplate
All Device Level Ring Objects (raC-12_02-VD) raC_Opr_NetDLR.vpd
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files include attachments of all required files for that object. The Device files 
are used to actually add that device into a Studio 5000® project and these 
reference the Asset Control files. 

All Studio 5000® Application Code Manager files can be found in the /
ApplicationCodeManagerLibraries/ folder of the library. The files included are as 
follows:

Operations The Network Device objects provide only physical operation mode. There is no 
virtual device mode offered.

Execution

The following table explains the handling of instruction execution conditions.

Implementation 
Object

Compatible
Network 
Configuration

Asset Control File (.HSL4) Device File (.HSL4)

DLR3

Up to 3 Device 
Level Rings each 
with up to 56 
nodes; Ring of 
Switches

(RA-LIB)_Device_Asset-Control_Network_raC_Opr_NetDLR3_(12.3) (RA-LIB)_Device_Device_Network_raC_LD_Opr_NetDLR3_(12.3)

Condition Description

EnableIn False (false rung)
Processing for EnableIn False (false rung) is handled the same as if the device were 
taken out of service by Command. The device outputs are de-energized and the device 
is shown as Program Out of Service on the HMI. All alarms are cleared.

Powerup (prescan, first 
scan)

On prescan, any commands that are received before first scan are discarded. The 
device is de-energized. On first scan, the device is treated as if it were returning from 
Hand command source: the instruction state is set based on the position feedback that 
is received from the device. If the feedback is valid for one position, the device is set to 
that position. If the device does not have position feedback or the position feedback is 
invalid, the device is set to the ‘unknown/powerup’ state.
The command source is set to its default, either Operator or Program (unlocked).

Postscan No SFC Postscan logic is provided.
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Add-On Instruction I/O Data InOut Data

Input Data

Output Data

Data Types A number of User-Defined Datatypes (UDT) are used in the Network Device 
Library. A full list of the UDTs used with the raC_Opr_NetDLR3 and 

InOut Function / Description  DataType

Ref_Paths UDT Containing CIP Path strings for Ring1, 
Ring2, Ring3, and up to 10 Stratix Switches raC_UDT_DLR3Paths10

Ref_Msg_Get_All Message used to read complete CIP 
objects. MESSAGE

Ref_Msg_Get_Single Message used to read vendor specific 
attributes. MESSAGE

Ref_Msg_Get_Member Message used to read member attributes MESSAGE

Ref_Msg_Rst_SignOn Message used to sign on to switch MESSAGE

Ref_Storage Stores CIP message data SINT[520]

Input Function/Description DataType

EnableIn Enable Input - System Defined Parameter  BOOL 

Inp_Enable Enable AOI functions. 1 = enabled. BOOL

Inp_RefreshInhibit Inhibit data refresh BOOL

Output Function/Descritpion DataType

EnableOut Enable Output - System Defined Parameter BOOL

Sts_EN AOI Enabled Status; 1 = enabled. BOOL

Sts_ER Message error bit; 1= Error BOOL

Sts_Connected Supervisor is responding. BOOL

Sts_Available Connected and in Ring Topology (not linear) BOOL

Sts_Faulted DLR faulted status: 1 = an active fault exists BOOL

Sts_Ring1_Faulted Ring 1 Fault present; 1= Faulted BOOL

Sts_Ring2_Faulted Ring 2 Fault present; 1= Faulted BOOL

Sts_Ring3_Faulted Ring 3 Fault present; 1= Faulted BOOL

Sts_PathError Message Path Error Present; 1 = Error BOOL

Ref_HMI Alias tag for HMI_Parameters.Tab_Active DINT
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raC_Opr_NetDLR3_Lite objects follows:

Add-On Instructions A number of embedded Add-On Instructions (AOI) are used within the 
raC_Opr_NetDLR3 and raC_Opr_NetDLR3_Lite instructions. These are used 
to convert between datatypes and generate values which can be read from the 
HMI faceplate. The following AOIs are included:

User Defined Datatype Description
raC_UDT_DLR3Dropdowns DLR Drop-down menu
raC_UDT_DLR3HMI DLR HMI Faceplate Information
raC_UDT_DLR3LocalData10 DLR HMI local data

raC_UDT_DLR3Paths10 CIP Message Path data for 3 rings and up tot 10
switches.

raC_UDT_DLR3Rings DLR HMI Faceplate Information - Ring
raC_UDT_DLR3Stratix_Ports DLR Port 1 and Port 2 status and MAC Address
raC_UDT_DLR3ValidPathsNoIP DLR Node with no IP address
raC_UDT_DLRActive_Node DLR Active Node Address
raC_UDT_DLRCapture_Error DLR Error Information
raC_UDT_DLRFaults DLR HMI Faceplate Information - Faults
raC_UDT_DLRHome DLR HMI Faceplate Information - Home Tab
raC_UDT_DLRLast_Node DLR Last Node Information
raC_UDT_DLRMAC DLR Mac Address
raC_UDT_DLRNode DLR HMI Faceplate Information - Node
raC_UDT_DLRNode_Info DLR Node Information
raC_UDT_DLRRedGateway DLR Redundant Gateway information
raC_UDT_DLRRing DLR HMI Faceplate Information - Ring
raC_UDT_DLRTakeover_Order DLR Takeover Precedence order
STR0002 String
STR0016 String
STR0032 String

User Defined Datatype Revision Description
raC_Tec_DecToHex 12.02 Converts decimal number to hexadecimal String
raC_Tec_DLRClearNodeInfo 12.02 Clears node information

raC_Tec_DLRIcon 12.02 Determines device icon used in DLR network 
schematic

raC_Tec_IPMACtoString_NET 12.02 Converts numerical IP/MAC address into user-
readable string

raC_Tec_MACCompare 12.02 Compares two MAC addresses

raC_Tec_PathSplit 12.02 Strips and separates the last IP address from 
the path

raC_Tec_PathToHex 12.02
Converts a comma separated string (as typed in 
“Path” of MSG) to Hex Path string as used in 
MSG.Path element

raC_Tec_MACFind_IPReplace 12.02

Finds DLR instance for Stratix 5400 based on 
the reported MAC and list of MAC addresses 
from individual Stratix ports involved in DLR, 
then replaces IP address of the message 
instruction.
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Programming Example Fully configured device on a rung is provided below for reference. 

Note that this programming example is the same code that is imported when 
either importing the supplied rung .L5X files or when using Application Code 
Manager or the Studio 5000® Import Library Objects wizard plug-in.

A diagram of the example is shown below for reference. This example includes: 
• 3 ring networks each connected to a 1756-EN2TR module (E/F/G) in 

slots 3, 4, and 5
• 2 Stratix 5400 switches (A/B) each with a direct connection back to a 

1756-EN2T (C/D) module in slots 1 and 2 for switch management and 
diagnostics.

The programming for this example uses the 3-Ring Device Level Ring device 
object named Dvc_DLR3.

A

B

Node

Node Node

Node Node

Node

C D E F G

A: Switch 1; 192.168.1.5
B: Switch 2; 192.168.2.5
C: 1756‐EN2T; 192.168.1.10
D: 1756‐EN2T; 192.168.2.10
E: 1756‐EN2TR; 192.168.10.5
F: 1756‐EN2TR; 192.168.20.5
G: 1756‐EN2TR; 192.168.30.5

CIP Switch Management
Ring 1
Ring 2
Ring 3
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The Ref_Paths points to the UDT variable called Dvc_DLR_Paths which contains 
message paths for 3 DLR rings and up to 10 switches. In this example we have 
the following strings message path strings configured:

See Message Paths for more information and examples on assigning this 
string. 

Graphic Symbols Graphic Symbols are used as launch buttons within HMI applications to open 
up faceplate displays. See Basic Launch Button Attributes section for details on 
configuration and indicators.

FactoryTalk® View ME/SE Graphic Symbols
Graphic Symbol Name Graphic Symbol Description Global Object Parameter Values

GO_LaunchFP

Faceplate navigation button with string tag label.
This launch button graphic object allows the user 
to navigate to the device object faceplate.
The text on the button face is set to the parameter 
#104.

#102: AOI Backing Tag Instance (e.g. 
{::[PAC]._InstanceName})
#104: Navigation Button Label
#120: Display’s left position (e.g. 100) (optional)
#121: Display’s top position (e.g. 100) (optional)
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Studio 5000 View Designer® Graphic Symbols

Text displayed in the launch buttons can be modified from the Properties tab 
using the General > Text parameter.

Faceplates There are basic faceplate attributes that are common across all instructions. 
See Basic Faceplate Attributes on page 22.

Faceplate Navigation

Graphic Symbol Name Graphic Symbol Description Property Configuration

btn_nav_NetDLR3_56Node_FP
Navigate to 56 Node 3 
Ring DLR Faceplate 
Pop-Up Screen
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• The Home tab provides connected ring network layout and node icons 
with device information (Catalog Number, IP Address). It also provides 
Ring 1, Ring 2 and Ring 3 selection using the drop-down menu.

• The Ring tab provides the Active Ring Supervisor details, Active 
Redundant Gateway details.

• The Node tab provides details for all connected nodes.
• The Fault tab provides network fault information and location.

Home

The Home screen is visible when the Home tab button is selected in the tab 
control object on the left side of the screen. The Home tab screen displays an 
auto-generated network layout. This example is displaying a 56-node network. 
The number and sequence of nodes are based on the information provided by 
the Active Ring Supervisor. 

In this screen, a drop-down menu is available for the ring selection.

The Active Ring Supervisor is always located on the upper left position of the 
screen and it is identified by the star icon at the upper right corner of the node.
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If the Backup Supervisor is configured, then it is identified by numerical icons 
at the upper right corner of the nodes. The numerical order indicates the order 
taken over by the supervisor, if the initial Active Ring Supervisor and 
subsequent Backup Supervisor cannot perform functions any longer.

In addition, each node will display its catalog number and IP address as 
reported by the device.

Detailed node information can be accessed by pressing the individual device 
Icons.

Devices without IP addresses can participate in the DLR and will be identified 
with a question mark. Device catalog number will be shown only if node 
responds to Identity request by the Add-On Instruction (AOI), otherwise a 
question mark icon will be shown. 
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If a network connection fault is detected, a Link Fault indicator represented by 
the round yellow circle with an exclamation mark will appear on the network 
layout at the point or points of failure. In addition, a yellow border will appear 
on the network fault tab navigation button. Once the failed connection is 
restored, the Link Fault indicator will disappear.

Note: Refer the Fault tab section for more information on the faults detected

If a node is no longer responding, for example, if node power turned off, then 
missing node will be shown with “X” sign over the device icon.

Once the node functionality and connections are restored, the node and the 
associated link appearance will be restored to the normal state.



Rockwell Automation Publication DEVICE-RM400B-EN-P - January 2024 137

Chapter 8          3-Ring Device Level Ring (raC_Opr_NetDLR3, raC_Opr_NetDLR3_Lite)

Ring Tab

The Ring Tab provides more information about the Device Level Ring network. 
A drop-down menu allows you first to select the desired ring. A second drop-
down menu allows users to select the detailed Ring Information, Active 
Supervisor Identity, Active Supervisor Capabilities or Redundant Gateway 
information.

Ring Information

The Ring information provides basic network configuration, status and 
diagnostic information to assist in troubleshooting potential network 
problems.



138 Rockwell Automation Publication DEVICE-RM400B-EN-P - January 2024

Chapter 8          3-Ring Device Level Ring (raC_Opr_NetDLR3, raC_Opr_NetDLR3_Lite)

Network Topology “Ring” state indicates that at least one node has the Active 
Ring Supervisor function enabled. The faceplate will be suspended if network 
is transitioned from the ring to the linear topology. 

Network “Normal” state indicates that the ring is functioning correctly and no 
link faults are present. Otherwise, network status will indicate the various type 
of faults as reported by the Active Ring Supervisor.

In addition, this display shows currently active DLR configuration parameters 
that can be used for DLR network configuration, maintenance and 
troubleshooting.

Please refer to the DLR user guides for more information.

https://literature.rockwellautomation.com/idc/groups/literature/documents/
at/enet-at007_-en-p.pdf

https://literature.rockwellautomation.com/idc/groups/literature/documents/
td/enet-td015_-en-p.pdf

Active Supervisor Identity

The Active Ring Supervisor is automatically determined based on the 
precedence value and MAC address. The Active Supervisor identity 
information helps the user to identify the device that is currently acting as the 
Active Ring Supervisor. This information includes the MAC address, IP 
address, Catalog Number, Vendor, Device Type, Product Code and Serial 

https://literature.rockwellautomation.com/idc/groups/literature/documents/at/enet-at007_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/td/enet-td015_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/td/enet-td015_-en-p.pdf
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Number. Firmware Revision helps with troubleshooting to determine if the 
device firmware is current.

This information is updated in real time and will reflect any changes in the 
Active Ring Supervisor.

Active Supervisor Capabilities

The Active Supervisor capability information provides the configuration and 
device capabilities of the Active Ring Supervisor which helps with device 
configuration and troubleshooting. See Node Capabilities for details.
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Redundant Gateway

If Redundant Gateway functionality is enabled on the DLR network, then this 
screen will display information about the device that acts as an Active 
Redundant Gateway, including IP address, MAC address and Gateway 
Precedence value. 

Redundant Gateway option is not applicable for 12-node DLR Network.
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Node Tab

The DLR faceplate also allows user to display information about all DLR 
participant nodes. For specific node information, select the Node Tab 
navigation button.
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A drop-down menu allows users to select the desired DLR network. The node 
selection drop-down menu at the top right side of the node tab display allows 
user to access a specific node based on the IP or MAC address.

Node Information

The Node Information display helps users to associate the specific node by one 
or more of its identity parameters:

Catalog Number, MAC address, IP address, Vendor, Device Type, Product 
Code, Serial number. It also allows to verify if firmware revision meets the user 
requirements.
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Node Mode

The Node Mode information provides the role of a specific node on the 
network, either normal node, Active Supervisor, or Backup Supervisor. 
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Please note that Supervisor Precedence is not the same as the Takeover Order 
shown on the Home screen. The Takeover order is calculated by the Add-On 
Instruction and is based on the precedence value and individual MAC 
addresses.

Node Capabilities

The Node Capabilities provide the information that potentially helps with 
node configuration and troubleshooting.
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The first two fields identify if the node’s DLR implementation is done in 
software (Announce-Based) or in Hardware (Beacon Based). 

Supervisor Capability indicates that a specific device can be configured as a 
supervisor.

Some Supervisor capable devices can act as Redundant Gateway allowing 
multiple uplink connections to the distribution layer switches.

The Flush Table capability is required for all nodes that are present on the DLR 
network where a Redundant Gateway is enabled.

Redundant Gateway

The Redundant Gateway Display will provide detailed node configuration 
parameters, if the node is configured for Redundant Gateway. It will also 
indicate the Redundant Gateway status for selected node.

This information allows users to troubleshoot an issue related to the 
Redundant Gateway connections and loss of data.
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Fault Tab

The Network Fault Tab provides details about network health. When a network 
fault occurs, it will indicate the fault type, fault location. Any fault clear/reset 
operations should be performed via advanced user tools like Device Manager 
or Studio 5000 Logix Designer® Add-On Profile.
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Network Fault

A fully functional DLR network should remain in Normal state. 
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When a network fault is detected, a yellow border will appear on the network 
fault tab navigation button and alarm symbol is present on faulted ring of 
dropdown list. Also, yellow border will appear on the ring selector dropdown of 
the rings (i.e., Ring 2 and Ring 3).

 

When a network fault occurs, the faceplate will indicate one of the following 
faults:

• Ring Fault
• Unexpected Loop Detected
• Partial Network Fault
• Rapid Fault/Restore Cycle Fault



Rockwell Automation Publication DEVICE-RM400B-EN-P - January 2024 149

Chapter 8          3-Ring Device Level Ring (raC_Opr_NetDLR3, raC_Opr_NetDLR3_Lite)

Ring Fault: The most common fault, the Ring Fault – usually occurs when one 
or more link is broken, or a node is taken off the network.

Unexpected Loop Detected: this fault occurs when the network ring was closed 
without defining at least one node as the Active Ring Supervisor – in Linear 
topology.
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Partial Network Fault: occurs when the Active Ring Supervisor detects 
network fault in one direction only.

 

 



Rockwell Automation Publication DEVICE-RM400B-EN-P - January 2024 151

Chapter 8          3-Ring Device Level Ring (raC_Opr_NetDLR3, raC_Opr_NetDLR3_Lite)

Rapid Fault/Restore Cycle fault: Occurs when there are more than 5 
consecutive fault/recovery cycles detected in less than 30 seconds. This usually 
happens during network commissioning and indicates a severe hardware or 
cabling issue, or misconfiguration that requires immediate attention. When 
this fault occurs, it is required to restore normal operations after the fault 
cause was determined and corrected. Then Rapid Fault/Restore reset should be 
performed via advanced user tools like Device Manager or Studio 5000 Logix 
Designer® Add-On profile.

Ring Fault Count indicates number of ring faults since the Active Ring 
Supervisor’s power-up or last fault reset. 

Please note that the counter is just a status indicator and does not affect DLR 
or faceplate operations. 

Ring Fault Reset should be performed via advanced user tools like Device 
Manager or Studio 5000 Logix Designer® Add-On Profile.
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Fault Location

The fault location information provides a potential breaking point as reported 
to the faceplate by the Active Ring Supervisor.

Warning Information

The faceplate also provides a series of warnings, here are few examples:

Faceplate Displays rely on the information provided by the Add-On 
Instruction. 

 



Rockwell Automation Publication DEVICE-RM400B-EN-P - January 2024 153

Chapter 8          3-Ring Device Level Ring (raC_Opr_NetDLR3, raC_Opr_NetDLR3_Lite)

If the Add-On Instruction operation is disabled by the user, then “AOI Not 
Enabled” warning message is shown and all faceplate operations will be 
suspended.

If the number of nodes on a 56-node faceplate exceeds the recommended limit 
of 50 nodes, then this warning will be displayed. 

Please note that while DLR does not has a physical node limit, Rockwell 
Automation recommends not to exceed 50 node limits. The user can disable or 
delete this message.
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If the detected number of nodes on the connected network exceeds 56 then the 
below warning will display and all faceplate operations will be suspended
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At least one Stratix path must be valid. If both are incorrect then the below 
warning will be displayed. The incorrect or invalid reference switch path 
defined in the Add-On Instruction parameters is likely the cause of this error.



156 Rockwell Automation Publication DEVICE-RM400B-EN-P - January 2024

Chapter 8          3-Ring Device Level Ring (raC_Opr_NetDLR3, raC_Opr_NetDLR3_Lite)

The incorrect or invalid reference ring path defined in the Add-On Instruction 
parameters is likely the cause of this error. 

The following screenshot is applicable for Ring 2 and Ring 3.

The following screenshot is applicable for Ring 1:
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If Ref_Paths contains IP address of a device that is not a part of DLR and has 
the Active Ring Supervisor function disabled, then the below warning will be 
displayed.

The initial scan of the network must be performed in “Normal” state where 
DLR is functioning without a fault or cable break. Otherwise, the following 
message will be displayed. Once DLR is restored to the Normal state, the 
faceplate will automatically build the network participant list and display 
current network topology. 
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Application Code Manager Network Device Library objects can be set-up and configured using Studio 
5000® Application Code Manager.

Refer to the section Using Application Code Manager for complete details.

Definition Objects: raC_Opr_NetDLR3

This Asset-Control object contains the Add-On Instruction definition and 
required data types. It is used as a linked library to the device implement 
object. This gives users the flexibility to choose to instantiate only definition 
and create custom implement code. A user may also create their own 
implement library and link with this definition library object.

Implementation Objects: raC_LD_Opr_NetDLR3

The Device Implementation Object is the rung that is instantiated when 
generating controller code using Application Code Manager. This 
implementation object includes a reference to the Asset-Control Add-On 
Instruction definition, along with any required controller tags, programs, 
modules, and HMI objects.

The DLR3 implementation has the following configuration parameters.
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Linked Libraries

Configured HMI Content

Parameter Name Default Value Instance Name Definition Description

RoutineName {ObjectName} {RoutineName} Routine

Enter Routine name.  Routine will be created and Object implement 
rung(s) inserted.  
A JSR will be inserted in MainRoutine.  
If routine name already exists, then object will be inserted into 
existing routine.  
By default, parameter is set to Object Name.

TagName {ObjectName} {TagName} Backing Tag
Enter the backing tag of the main AOI.
This will serve as the base tag name for other tags in this object that 
are derived from the base.

TagDescription {ObjectDescription} {TagDescription} Tag Description of the main AOI backing tag

Ref_Path_Ring1_Path Enter a valid CIP Message Path to any device on Ring 1. See Message 
Paths for more information.

Ref_Path_Ring2_Path Enter a valid CIP Message Path to any device on Ring 2. See Message 
Paths for more information.

Ref_Path_Ring3_Path Enter a valid CIP Message Path to any device on Ring 3. See Message 
Paths for more information.

Ref_Switch_Paths0 Enter a valid CIP Message Path to a switch connected to the DLR 
networks. See Message Paths for more information.

Ref_Switch_Paths1 Enter a valid CIP Message Path to a switch connected to the DLR 
networks. See Message Paths for more information.

In Application Code Manager you can configure up to 2 Switch Paths for device 
monitoring and diagnostics within the DLR faceplate. The Add-On Instruction 
supports up to 10 switch paths. The remaining paths can be configured directly in 
the raC_UDT_DLR3Path10 UDT.

Link Name Catalog Number Revision  Solution   Category

raC_Opr_NetDLR3 raC_Opr_NetDLR3 12.2 (RA-LIB) Device Network

HMI Content Instance Name  Description

Launch Button {ObjectName}_GO_Launch_Three56N Global Object launch button to DLR3 56 Node Faceplate using basic 
text label.
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Attachments

 Name Description File Name Extraction Path

V12_Network_Images Images HMI Factory Talk View Images - png.zip {ProjectName}\Visualization\Images

V12_raC_Dvc_Network_Global Graphic Symbols ME (raC-12-ME) Graphic Symbols - Network Device.ggfx {ProjectName}\Visualization\FTViewME\GlobalObjects

V12_raC_Dvc_Network_Global Toolbox ME (raC-12-ME) Toolbox - Network Device.ggfx {ProjectName}\Visualization\FTViewME\GlobalObjects

V12_raC_Dvc_Network_Global Toolbox SE (raC-12-SE) Toolbox - Network Device.ggfx {ProjectName}\Visualization\FTViewSE\GlobalObjects

V12_raC_Dvc_Network_Global Graphic Symbols SE (raC-12-SE) Graphic Symbols - Network Device.ggfx {ProjectName}\Visualization\FTViewSE\GlobalObjects

RM_raC_Dvc_Network Reference Manual DEVICE-RM400B-EN-P.pdf {ProjectName}\Documentation

V12_raC_Dvc_DLR3_56Node Faceplate SE (raC-12_xx-SE) raC_Opr_NetDLR3_56Node-Faceplate.gfx {ProjectName}\Visualization\FTViewSE\Displays

V12_raC_Dvc_DLR3_56Node Faceplate ME (raC-12_xx-ME) raC_Opr_NetDLR3_56Node-Faceplate.gfx {ProjectName}\Visualization\FTViewME\Displays

V12_raC_Opr_NetDLR View Designer (raC-12_xx-VD) raC_Opr_NetDLR.vpd {ProjectName}\Visualization\ViewDesigner
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Overview The Parallel Redundancy Protocol (PRP) device object (raC_Opr_NetPRP) 
includes HMI faceplates for PRP networks which displays network 
information including:

• PRP Node Table 
• PRP Node Diagnostics
• PRP Node Identity

The raC_Opr_NetPRP object can be used for PRP networks containing up to 
240 nodes.

Functional Description The PRP Network objects:
• Collects and processes data from one of the PRP network devices (1756-

EN2TP, 1756-EN4TR, 5094-AEN2TR, Stratix switch) 
• Provides diagnostic data for PRP Node tables, streamlining network 

maintenance and minimizing network downtime.

All these features provide quick feedback, shorten recovery time, and simplify 
implementation.

Required Files Device Objects include Add-On Instructions (AOIs) and HMI faceplates. The 
revision number (e.g. 1.01) used in filenames can change as new revisions are 
created.

Controller Files

Add-On Instructions are reusable code objects that contain encapsulated logic 
that can streamline implementing your system. This lets you create your own 
instruction set for programming logic as a supplement to the instruction set 
provided natively in the ControlLogix® firmware. An Add-On Instruction is 
defined once in each controller project, and can be instantiated multiple times 
in your application code as needed.

The Add-On Instruction must be imported into the controller project to be 
used in the controller configuration. These can be imported as Add-On 

In the Library there is a folder named Videos which contains many How-To and 
Operational Overview Videos which walk step-by-step through each process. You 
can refer to the following videos for this section:
“Operational Overview of PRP Object Faceplates”
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Instruction files, or as part of the Rung Import or Import Library Objects 
wizard. 

All Add-On Instruction and Rung Import files can be found in the /Studio 5000 
Logix Designer Files - L5X/ folder in the library. 

FactoryTalk® View HMI Files

FactoryTalk® View ME and FactoryTalk® View SE applications require 
importing the desired device faceplates in addition to all Global Object (ggfx) 
files and all images located in the /HMI FactoryTalk® View Images - png/ folder of 
the library. FactoryTalk® View ME files are stored in the /HMI - FactoryTalk® 
View ME/ library folder and FactoryTalk® View SE files are stored in the /HMI - 
FactoryTalk® View SE/ library folder.

Studio 5000 View Designer® HMI Files

All Studio 5000 View Designer® Files can be found in the /HMI - ViewDesigner - 
vpd/ folder of the library.

Studio 5000® Application Code Manager Files

Studio 5000® Application Code Manager (ACM) can be optionally used if it is 
installed. All devices can be easily registered in the ACM repositories by 
running the setup.cmd file located in the root folder of the library.

Individual HSL4 files are provided as an alternative to running the setup.cmd 
to allow users to manually register specific implementation objects. Each 
object has two files - an Asset Control file and a Device file. The Asset Control 
files include attachments of all required files for that object. The Device files 

Object Compatible
Network Configuration Add-On Instruction Rung Import

raC_Opr_NetPRP
PRP Node Table applicable with 
1756-EN2TP, 1756-EN4TR, 
5094-AEN2TR And maximum 240 
PRP Nodes

raC_Opr_NetPRP_12.03_AOI.L5X raC_Opr_NetPRP_12.03_RUNG.L5X

Device/Item Type FactoryTalk® View ME
Faceplate

FactoryTalk® View SE
Faceplate

raC_Opr_NetPRP Display (raC-12_03-ME) raC_Opr_NetPRP-Faceplate.gfx (raC-12_03-SE) raC_Opr_NetPRP-Faceplate.gfx
Graphic Symbols Global Object (raC-12-ME) Graphic Symbols - Network Device (raC-12-SE) Graphic Symbols - Network Device
Toolbox Global Object (raC-12-ME) Toolbox -Network Device.ggfx (raC-12-SE) Toolbox -Network Device.ggfx

Device/Item Studio 5000 View Designer® Faceplate
Network Objects (raC-12_03-VD) raC_Opr_NetPRP_FP.vpd
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are used to actually add that device into a Studio 5000® project and these 
reference the Asset Control files. 

All Studio 5000® Application Code Manager files can be found in the /
ApplicationCodeManagerLibraries/ folder of the library. The files included are as 
follows:

Operations The Network Device objects provide only physical operation mode. There is no 
virtual device mode offered.

Execution

The following table explains the handling of instruction execution conditions.

Implementation 
Object Asset Control File (.HSL4) Device File (.HSL4)

PRP (RA-LIB)_Device_Asset-Control_Network_raC_Opr_NetPRP_(12.03) (RA-LIB)_Device_Device_Network_raC_LD_Opr_NetPRP (12.03)

Condition Description

EnableIn False (false rung)
Processing for EnableIn False (false rung) is handled the same as if the device were 
taken out of service by Command. The device outputs are de-energized and the device 
is shown as Program Out of Service on the HMI. All alarms are cleared.
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Add-On Instruction I/O Data InOut Data

Input Data

Output Data

InOut Function / Description  DataType

Ref_Module Reference Module MODULE

Ref_MsgGetSgl Message used to read vendor specific 
attributes. MESSAGE

Ref_MsgGetAll Message used to read vendor specific 
attributes. MESSAGE

Ref_MsgGetMember Message used to read Member Information 
vendor specific attributes. MESSAGE

Ref_MsgGetSglNode Message used to read vendor specific 
attributes. MESSAGE

Ref_MsgGetAllNode Message used to read vendor specific 
attributes. MESSAGE

Ref_MsgData Message Destination Address. SINT[503]

Input Function/Description DataType

EnableIn Enable Input - System Defined Parameter BOOL

Inp_Enable Enable AOI functions. 1 = enabled. BOOL

Set_SampleInterval Status and diagnostic information cycle update in second. Default 
Value - 8 sec. DINT

Set_SampleInterval value as per the total node count in the PRP Network. Tested 
with Set_SampleInterval value 6 sec. for 56 nodes in 100ms Periodic Task. (The 
Set_Sample Interval value depend on Periodic Task where AOI rung imported & Total 
no. of node count)

Output Function/Descritpion DataType

EnableOut Enable Output - System Defined Parameter BOOL

Sts_EN AOI Enabled Status; 1 = enabled BOOL

Sts_ER Message error bit; 1= Error BOOL

Sts_Connected Device is connected to the Programmable 
Controller

BOOL

Sts_Available Connected and in the PRP Topology BOOL

Sts_Faulted Device faulted status: 1 = LAN A or LAN B not OK BOOL

Val_MejorRevision Mejor revision of Device SINT

Val_MinorRevision Minor revision of Device SINT

Val_ProductCode Product Code INT

Val_TotalIPDevices Total Non-zero (0.0.0.0) IP Address
Nodes after filter.

DINT
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Data Types A number of User-Defined Datatypes (UDT) are used in the Network Device 
Library. A full list of the UDTs used with the raC_Opr_NetPRP and object 
follows:

Add-On Instructions A number of embedded Add-On Instructions (AOI) are used within the 
raC_Opr_NetPRP instruction. These are used to convert between datatypes 
and generate values which can be read from the HMI faceplate. The following 
AOIs are included:

Val_WarningCountLanA Warning Count LAN A DINT

Val_WarningCountLanB Warning Count LAN B DINT

Val_WarningLanA 1 = Warning on LAN A SINT

Val_WarningLanB 1 = Warning on LAN B SINT

Val_DeviceType 12=Communication Adapter, 14=Progammable 
Controller, 44=Switch, 24=HMI, 7=Discrete I/O,

INT

Val_MsgErr CIP Message Error Indicatior SINT

Val_TotalDevices Total node count in PRP Table DINT

Sts_StratixNode 1 = Connected reference module is Stratix 
Switch

BOOL

Val_NodeType 0=Deprecated (PRP Mode 0), 1=PRP Mode 1, 
2=HSR Mode, 3-65535=Reserved for Future use.

INT

Output Function/Descritpion DataType

User Defined Datatype Description
raC_UDT_DLRMAC Raw MAC
raC_UDT_PRPDuplicateDetectCounter LRE Duplicate detection counters
raC_UDT_PRPInterfaceCounter LRE Interface counters
raC_UDT_PRPNodeTableHMI PRP Node Table Member Information

User Defined Datatype Revision Description

raC_Tec_IPMACtoString 1.01 Converts numerical IP address into user-readable 
string

raC_Tec_IPtoString_NET 2.00 Converts numerical IP address into user-readable 
string

raC_Tec_MsgPathFormation 1.00 Provide Appropriate message path

raC_Tec_GetMembersPRP 1.02 Get Members Service (0x18) for PRP Object (0x57) 
Instance attributes 2&3

raC_Tec_DecToHex 12.02 Converts Decimal number to Hexadecimal String
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Programming Example Fully configured device on a rung is provided below for reference. 

Note that this programming example is the same code that is imported when 
either importing the supplied rung .L5X files or when using Application Code 
Manager or the Studio 5000® Import Library Objects wizard plug-in.

In this example DAN_Local is the name of a PRP enabled module such as a 1756-
EN2TP communications adapter.

Graphic Symbols Graphic Symbols are used as launch buttons within HMI applications to open 
up faceplate displays. See Basic Launch Button Attributes section for details on 
configuration and indicators.

FactoryTalk® View ME/SE Graphic Symbols

Studio 5000 View Designer® Graphic Symbols

Text displayed in the launch buttons can be modified from the Properties tab 
using the General > Text parameter.

Graphic Symbol Name Graphic Symbol Description Global Object Parameter Values

GO_LaunchFP

Faceplate navigation button with string tag label.
This launch button graphic object allows the user 
to navigate to the device object faceplate.
The text on the button face is set to the parameter 
#104.

#102: AOI Backing Tag Instance (e.g. 
{::[PAC]._InstanceName})
#104: Navigation Button Label
#120: Display’s left position (e.g. 100) (optional)
#121: Display’s top position (e.g. 100) (optional)

Graphic Symbol Name Graphic Symbol Description Property Configuration

btn_nav_raC_Opr_NetPRP_FP
Navigate to NetPRP 
Faceplate Pop-Up 
Screen
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Faceplates There are basic faceplate attributes that are common across all instructions. 
See Basic Faceplate Attributes on page 22.

In this document, the faceplate pictures (or snapshots) shows the information 
of PRP node table of PRP Network. 

Faceplate Navigation

• The Home tab provides PRP Node table information of (MAC Address, 
IP Address, Active Port A, Active Port B, and Node type).

• The Diagnostic tab provides various types of counts for Port A & Port B 
which used to analysis PRP Network of that node. Also provides the 
node identity of that node.
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Home

The Home screen is visible when the Home tab button is selected on the left 
side of the screen. Within the “Home Tab”, you will find information on the 
PRP Node table, including total node count and a node table of all active nodes. 
The PRP Node table details contains MAC Address, IP Address, Active Port A 
status, Active Port B status, and Node type.

An active (blue) LED indicates the node’s Port A and/or Port B connection 
status. An inactive (gray) LED indicates that there is no connection on the 
respective port. The node type is set to one of the following types:

• DAN: Double attached node. An end device with PRP technology that 
connects to both LAN A and LAN B.

• SAN: Single attached node. An end device without PRP technology that 
connects to either LAN A or LAN B. A SAN does not have PRP 
redundancy.

• RedBox: Redundancy box. A switch with PRP technology that connects 
devices without PRP technology to both LAN A and LAN B.

• VDAN: Virtual double attached node. An end device without PRP 
technology that connects to both LAN A and LAN B through a RedBox. A 
VDAN has PRP redundancy and appears to other nodes in the network 
as a DAN.
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Use the page navigation buttons to view other nodes. 

Enable the filter button to filter and display only non-zero (0.0.0.0) IP Address 
Nodes.

If you select an any filtered IP Address row it will navigate to second tab and displays 
the Detailed node diagnostic data of that PRP Node.



170 Rockwell Automation Publication DEVICE-RM400B-EN-P - January 2024

Chapter 9          Parallel Redundancy Protocol (raC_Opr_NetPRP)

You can also navigate the other IP Address node information from here by using next 
or previous arrow button below the Diagnostic of Node table. This is visible only if 
the filter is applied.
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Diagnostic Tab

Within the “Diagnostic tab” you will find a detailed node diagnostic data of the 
selected node. If the filter is not enabled on the home tab, this will link directly 
to the reference module assigned to the Add-On Instruction’s Ref_Module tag. 
Users can easily monitor the Network status, Network fault count, Transit & 
receive count, Wrong LAN Count, Unique entry Count, Duplicate entry count 
and multiple entry count of PORT A & PORT B to diagnose the PRP network.

The diagnostic tab also allows user to display information of node identity. 
Click the Node Identity button to display the node associated identity 
parameters catalog number, mac address, IP address, vendor, device type, 
product code, serial number, firmware revision.

Click the Node Diagnostic button to return to the previous page.
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Warning Information

The faceplate also provides a series of warnings, here are few examples:

Faceplate Displays rely on the information provided by the Add-On 
Instruction. 

• If the Add-On Instruction operation is disabled by the user, then an 
“AOI Not Enabled” warning message is shown and all faceplate 
operations will be suspended.
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• If the Add-On Instruction message to the Reference module node failed 
it will display the “Add-On Instruction message to the PRP Node failed” 
message on all tabs.

• In the Home Tab if you click on filtered IP address row and the AOI 
Message failed, it will display the “PRP diagnostic data is not available 
for this node” message on Diagnostic tab.
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• If the connected PRP Network has PRP Node table count more than 
240, it will display the warning message “The connected network 
exceeded recommended limit of 240 nodes” in bottom right home tab.

• If the AOI Reference module connected to Stratix Switch it will display 
the warning message “PRP Node table data is not available for this 
module” on home tab.
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Application Code Manager Network Device Library objects can be set-up and configured using Studio 
5000® Application Code Manager.

Refer to the section Using Application Code Manager for complete details.

Definition Objects: raC_Opr_NetPRP

This Asset-Control object contains the Add-On Instruction definition and 
required data types. It is used as a linked library to the device implement 
object. This gives users the flexibility to choose to instantiate only definition 
and create custom implement code. A user may also create their own 
implement library and link with this definition library object.

Implementation Objects: raC_LD_Opr_NetPRP

The Device Implementation Object is the rung that is instantiated when 
generating controller code using Application Code Manager. This 
implementation object includes a reference to the Asset-Control Add-On 
Instruction definition, along with any required controller tags, programs, 
modules, and HMI objects.

The PRP implementation has the following configuration parameters.

Linked Libraries

Parameter Name Default Value Instance Name Definition Description

RoutineName {ObjectName} {RoutineName} Routine

Enter Routine name.  Routine will be created and Object implement 
rung(s) inserted.  
A JSR will be inserted in MainRoutine.  
If routine name already exists, then object will be inserted into 
existing routine.  
By default, parameter is set to Object Name.

TagName {ObjectName} {TagName} Backing Tag
Enter the backing tag of the main AOI.
This will serve as the base tag name for other tags in this object that 
are derived from the base.

TagDescription {ObjectDescription} {TagDescription} Tag Description of the main AOI backing tag

Link Name Catalog Number Revision Solution Category

raC_Opr_NetPRP raC_Opr_NetPRP 12.03 (RA-LIB) Device Network
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Configured HMI Content

Attachments

HMI Content Instance Name Description

Launch Button {ObjectName}_GO_LaunchFP_Text Global Object launch button using basic text label.

 Name Description File Name Extraction Path

V12_Network_Images Images HMI Factory Talk View Images - png.zip {ProjectName}\Visualization\Images

V12_raC_Dvc_Network_Global Graphic Symbols ME (raC-12-ME) Graphic Symbols - Network Device.ggfx {ProjectName}\Visualization\FTViewME\GlobalObjects

V12_raC_Dvc_Network_Global Toolbox ME (raC-12-ME) Toolbox - Network Device.ggfx {ProjectName}\Visualization\FTViewME\GlobalObjects

V12_raC_Dvc_Network_Global Toolbox SE (raC-12-SE) Toolbox - Network Device.ggfx {ProjectName}\Visualization\FTViewSE\GlobalObjects

V12_raC_Dvc_Network_Global Graphic Symbols SE (raC-12-SE) Graphic Symbols - Network Device.ggfx {ProjectName}\Visualization\FTViewSE\GlobalObjects

RM_raC_Dvc_Network Reference Manual DEVICE-RM400B-EN-P.pdf {ProjectName}\Documentation

V12_raC_Opr_NetPRP Faceplate SE (raC-12_XX-SE) raC_Opr_NetPRP- Faceplate.gfx {ProjectName}\Visualization\FTViewSE\Displays

V12_raC_Opr_NetPRP Faceplate ME (raC-12_XX-ME) raC_Opr_NetPRP- Faceplate.gfx {ProjectName}\Visualization\FTViewME\Displays

V12_raC_Opr_NetPRP View Designer (raC-12_xx-VD) raC_Opr_NetPRP_FP.vpd {ProjectName}\Visualization\ViewDesigner



Rockwell Automation Publication DEVICE-RM400B-EN-P - January 2024 177

Rockwell Automation Network Device Library Reference Manual



Publication DEVICE-RM400B-EN-P - January 2024  
Supersedes Publication DEVICE-RM400B-EN-P - January 2024 Copyright © 2024 Rockwell Automation, Inc. All rights reserved. Printed in the U.S.A

Rockwell Automation Support
Use these resources to access support information.

Documentation Feedback
Your comments help us serve your documentation needs better. If you have any suggestions on how to improve our content, complete the 
form at rok.auto/docfeedback.

Waste Electrical and Electronic Equipment (WEEE)

Rockwell Automation maintains current product environmental information on its website at rok.auto/pec.

Technical Support Center Find help with how-to videos, FAQs, chat, user forums, and product notification updates. rok.auto/support

Knowledgebase Access Knowledgebase articles. rok.auto/knowledgebase

Local Technical Support Phone Numbers Locate the telephone number for your country. rok.auto/phonesupport

Literature Library Find installation instructions, manuals, brochures, and technical data publications. rok.auto/literature

Product Compatibility and Download Center 
(PCDC)

Get help determining how products interact, check features and capabilities, and find 
associated firmware. rok.auto/pcdc

At the end of life, this equipment should be collected separately from any unsorted municipal waste.

Rockwell Otomasyon Ticaret A.Ş. Kar Plaza İş Merkezi E Blok Kat:6 34752, İçerenkÖy, İstanbul, Tel: +90 (216) 5698400 EEE YÖnetmeliğine Uygundur

Allen-Bradley, ArmorStart, CompactLogix, ControlLogix, FactoryTalk, Integrated Architecture, iTRAK, Kinetix, Logix 5000, MagneMotion, PlantPAx, PowerFlex, RSLinx, RSLogix, RSLogix 5000, SoftLogix, 
Stratix, Studio 5000, Studio 5000 Logix Designer, TechConnect, Rockwell Automation, and Rockwell Software are trademarks of Rockwell Automation, Inc.
EtherNet/IP is a trademark of ODVA, Inc.
Microsoft and Windows are trademarks of Microsoft.
Trademarks not belonging to Rockwell Automation are property of their respective companies.

https://rok.auto/pec
https://rok.auto/support
https://rok.auto/knowledgebase
https://rok.auto/phonesupport
www.rockwellautomation.com/literature
https://rok.auto/pcdc
http://literature.rockwellautomation.com/idc/groups/literature/documents/du/ra-du002_-en-e.pdf
https://rok.auto/docfeedback
https://www.instagram.com/rokautomation/
http://https://www.linkedin.com/company/rockwell-automation
http://https://twitter.com/ROKAutomation
https://www.facebook.com/ROKAutomation/
https://www.rockwellautomation.com/

	Network Device Library
	Table of Contents
	Preface
	Device Object Libraries Overview
	Application Code Manager
	Other Application Code Libraries
	Software and Firmware Upgrades
	Rockwell Automation® Services and Support

	Rockwell Automation® Network Device Library
	Compatibility
	Compatible Software
	Compatible Hardware

	Summary of Changes
	Footprint
	Additional resources

	Library Components
	Network Device Instructions
	Library Folders and Files
	Visualization Files
	Studio 5000 View Designer® Visualization Files

	Basic Faceplate Attributes
	Common Status Banner
	Faceplate Navigation

	Faceplate Revision Notes
	Library Versions
	State Model
	Interfaces
	Application Code Manager
	Architectural Overview


	Using the Library
	Install the Library
	Download the Library
	Download & Install Studio 5000® Application Code Manager
	Register Libraries in Studio 5000® Application Code Manager
	Register Complete Library Automatically
	Register Individual Library Objects Manually


	Message Paths
	Message Path Example 1 - ControlLogix® with Dual-Port Ethernet Module
	Message Path Example 2 - CompactLogix® 5370 with Dual-Ports
	Message Path Example 3 - CompactLogix® 5370 with ETAP
	Message Path Example 4- ControlLogix® with Single-Port Ethernet Module
	Message Path Example 5 - CompactLogix® 5380 with Ports in DLR Mode
	Message Path Example 6- CompactLogix® 5380 with Ports in Dual IP Mode

	Importing Logic into Studio 5000® Projects
	Import Library Objects Wizard
	Stratix® Configuration
	DLR Configuration

	Import Rung Logic

	Using Studio 5000 View Designer®
	Using Studio 5000 View Designer® Project Files
	Configuring View Designer Objects

	Using FactoryTalk® View Studio
	Import FactoryTalk® View Visualization Files
	Configuring FactoryTalk® View Objects

	Library Upgrades
	Add-On Instruction Upgrades
	Upgrades Using Studio 5000® Plug-In to Import Library Objects
	Upgrades by Importing AOI.L5X Files

	FactoryTalk® View Upgrades
	Studio 5000 View Designer® Upgrades


	Using Application Code Manager
	Overview of Application Code Manager
	Creating a New Project
	Adding & Configuring Device Objects
	Adding Stratix Device Instructions
	Adding DLR Device Object

	Configuring Displays
	Generating Displays
	Importing Displays into FactoryTalk® View Studio
	Generating Controller Files
	Exporting Attachments

	Using the Network Device Library with Other Application Code Libraries
	Application Code Libraries

	Stratix® Switch (raC_Dvc_Stratix)
	Overview
	Functional Description
	Required Files
	Controller Files
	FactoryTalk® View HMI Files
	Studio 5000 View Designer® HMI Files
	Studio 5000® Application Code Manager Files

	Operations
	Execution

	Add-On Instruction I/O Data
	InOut Data
	Input Data
	Output Data

	Data Types
	raC_UDT_ItfAD_Stratix_Sts
	raC_UDT_Event
	raC_UDT_LookupMember_STR0082

	Add-On Instructions
	Programming Example
	Graphic Symbols
	FactoryTalk® View ME/SE Graphic Symbols
	Studio 5000 View Designer® Graphic Symbols

	Faceplates
	Home
	Switch Tab
	Switch Tab - General
	Switch Tab - Configuration
	Switch Tab - VLAN
	Switch Tab - Time Sync

	Port Tab
	Port - Status
	Port - Statistics
	Port - Media Counter
	Port - Thresholds
	Port - Time Sync

	Alarm Tab
	Global Alarms
	Port Alarms

	Banner

	Application Code Manager
	Definition Objects: raC_Dvc_Stratix
	Implementation Objects: raC_LD_Dvc_Stratix
	Linked Libraries
	Configured HMI Content
	Attachments


	Single Device Level Ring (raC_Opr_NetDLR1, raC_Opr_NetDLR1_Lite)
	Overview
	Functional Description
	Required Files
	Controller Files
	FactoryTalk® View HMI Files
	Studio 5000 View Designer® HMI Files
	Studio 5000® Application Code Manager Files

	Operations
	Execution

	Add-On Instruction I/O Data
	InOut Data
	Input Data
	Output Data

	Data Types
	Add-On Instructions
	Programming Example
	Graphic Symbols
	FactoryTalk® View ME/SE Graphic Symbols
	Studio 5000 View Designer® Graphic Symbols

	Faceplates
	Home
	Ring Tab
	Ring Information
	Active Supervisor Identity
	Active Supervisor Capabilities
	Redundant Gateway

	Node Tab
	Node Information
	Node Mode
	Node Capabilities
	Redundant Gateway

	Fault Tab
	Network Fault
	Fault Location
	Warning Information


	Application Code Manager
	Definition Objects: raC_Opr_NetDLR1
	Implementation Objects: raC_LD_Opr_NetDLR1
	Linked Libraries
	Configured HMI Content
	Attachments


	3-Ring Device Level Ring (raC_Opr_NetDLR3, raC_Opr_NetDLR3_Lite)
	Overview
	Functional Description
	Required Files
	Controller Files
	FactoryTalk® View HMI Files
	Studio 5000 View Designer® HMI Files
	Studio 5000® Application Code Manager Files

	Operations
	Execution

	Add-On Instruction I/O Data
	InOut Data
	Input Data
	Output Data

	Data Types
	Add-On Instructions
	Programming Example
	Graphic Symbols
	FactoryTalk® View ME/SE Graphic Symbols
	Studio 5000 View Designer® Graphic Symbols

	Faceplates
	Home
	Ring Tab
	Ring Information
	Active Supervisor Identity
	Active Supervisor Capabilities
	Redundant Gateway

	Node Tab
	Node Information
	Node Mode
	Node Capabilities
	Redundant Gateway

	Fault Tab
	Network Fault
	Fault Location
	Warning Information


	Application Code Manager
	Definition Objects: raC_Opr_NetDLR3
	Implementation Objects: raC_LD_Opr_NetDLR3
	Linked Libraries
	Configured HMI Content
	Attachments


	Parallel Redundancy Protocol (raC_Opr_NetPRP)
	Overview
	Functional Description
	Required Files
	Controller Files
	FactoryTalk® View HMI Files
	Studio 5000 View Designer® HMI Files
	Studio 5000® Application Code Manager Files

	Operations
	Execution

	Add-On Instruction I/O Data
	InOut Data
	Input Data
	Output Data

	Data Types
	Add-On Instructions
	Programming Example
	Graphic Symbols
	FactoryTalk® View ME/SE Graphic Symbols
	Studio 5000 View Designer® Graphic Symbols

	Faceplates
	Faceplate Navigation
	Home
	Diagnostic Tab
	Warning Information

	Application Code Manager
	Definition Objects: raC_Opr_NetPRP
	Implementation Objects: raC_LD_Opr_NetPRP
	Linked Libraries
	Configured HMI Content
	Attachments



